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1 PURPOSE OF THIS MANUAL 

This manual describes the policies, procedures and controls to be exercised in accounting and 
reporting the financial activities of the Diocese of the West.  It is designed for use by the 
Treasurer of the Diocese of the West to facilitate compliance with policy and ensure consistent 
procedures are followed.   

Diocesan computer user ids and passwords are found in the Appendix, which is contained in a 
separate file from that of this manual.  The Appendix may not be posted on any computer or 
internet site. 

A copy of this manual must be kept in the Office of the Treasurer as well as in the Diocesan 
Office.   

2 DESCRIPTION OF THE DIOCESE OF THE WEST 

The Diocese of the West, Orthodox Church in America was established as a religious non-profit 
501c(3) corporation in 1975 under the laws of the State of California.  The Diocese of the West 
is a body of the Orthodox Church in America and consists of all parishes, mission parishes, 
missions, chapels and institutions of that Church within that Geographical territory defined by 
the Holy Synod of Bishops of the Orthodox Church in America as constituting the Diocese of the 
West.  Currently, the Diocese has parishes in the states of California, Oregon, Washington, 
Montana, Colorado, Nevada, Arizona, and Hawaii.   

The Diocese is administered by the canonically recognized Bishop of San Francisco, currently 
His Grace Bishop BENJAMIN.  The Board of the Directors shall be called the Diocesan 
Council. The principal office of the Diocese is located in the City and County of San Francisco, 
California at 1520 Green Street. 

 

3 GENERAL RESPONSIBILITIES 

Treasurer of the Diocese of the West – the Treasurer shall maintain this manual and shall 
provide a hard copy for review by the Diocesan Council and Diocesan Auditing Committee upon 
request.  The Treasurer shall also provide a copy of this manual during the review of the 
financial records by an external auditor. 

The Treasurer and the Auditing Committee - responsible for ensuring that accurate records 
are maintained and the specified internal controls are in place and exercised.  Cost effective 
internal controls have been selected to minimize expense to the diocese yet reduce the possibility 
of the misuse of funds.  

The Finance/Budget Committee – assists the Diocesan Council in its oversight responsibilities 
relating to fiscal management.  It shall prepare and recommend approval of an annual operating 
budget; regularly review financial results; ensure the maintenance of an appropriate capital 
structure; oversee the management of organization-wide financial assets.  It shall regularly 
review this Accounting Procedures Policy and Procedure Manual, make recommendations for 
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policy revisions, and present revised versions of this manual to the Diocesan Council for 
approval. 

4 THE TREASURER OF THE DIOCESE OF THE WEST   

4.1 Duties 
According to the bylaws of the Diocese (30 October 1995), the Treasurer of the Diocese of the 
West shall be responsible for:   

 
• the receipt, safekeeping, and proper disbursement of all money and other property of the 

Diocese entrusted to his care, according to the direction of the Diocesan Council 
• rendering a statement at the Diocesan Assembly and at such other times as may be 

requested by the Diocesan Council.  The annual statement shall be audited and certified 
as provided by these Bylaws 

• shall maintain, or have maintained, such account books, records, and procedures as 
necessary to fulfill the needs of accountability to Diocesan authority and to such legal 
and civil authorities or entities with legally constituted interest in Diocesan financial 
affairs.  Such accounts, records and procedures shall remain available for inspection by 
any member, at any time during normal hours, upon reasonable notification 

• performing such other duties as may be imposed by law, the Articles of Incorporation, 
these Bylaws, and decisions of the Diocesan Council 

 

4.2 Qualifications 
As specified in the bylaws, the Treasurer is appointed by the Diocesan Council from among its 
numbers. The term of office shall be for one year. 

The Treasurer must understand accounting principles and must be able to use QuickBooks 
accounting software to record financial transactions and create reports.  The Treasurer need not 
be a professional accountant, but non-profit bookkeeping experience is desirable.  The Treasurer 
must also be able to use Microsoft Word, Excel, Outlook, and email. This position requires 
approximately 30 to 40 hours of work per week to properly exercise all responsibilities.  

  

5 THE AUDITING COMMITTEE 

5.1 Duties 
The Diocesan bylaws state that: 

The Auditing Committee shall be composed of three members, one clergy and two lay, 
preferably with accounting or bookkeeping experience, who shall periodically review the 
work of the Treasurer and of the financial aspect of the work of the Diocesan Council.  The 
committee shall also audit and approve the annual financial report of the Diocesan Council 
before it may be mailed to the parishes.  The Auditing Committee shall audit the financial 
records of all Committees of the Diocesan Council and all auxiliary Diocesan 
organizations. 
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The Audit Committee shall periodically review this manual and verify that the procedures, 
policies and controls specified are followed.  The Audit Committee shall make recommendations 
as needed to ensure that the specified controls are adequate for the current operating 
environment.  They shall also oversee the financial reporting process and the hiring and 
performance of the external auditors.  

5.2 Qualifications 
The Auditing Committee shall be composed of three members, one clergy and two lay, 
preferably with accounting or bookkeeping experience. 

6 FINANCIAL RECORDS & CONTINGENCY PLAN 

Current year paper records are stored by month in hanging folders in a rolling file box under the 
treasurer’s desk.  The office of the Treasurer is located at 22 Dunraven PL, Port Townsend WA 
98368. The only items not scanned and stored on the treasurer’s computer are the receipts 
submitted to substantiate expenses paid with the Diocesan Credit Card or to substantiate 
reimbursable expenses.  The Treasurer is responsible for the maintenance of paper records 
according to the Document Retention Policy provided in the Appendix of this manual. 
All electronic Diocesan financial documents are stored on the treasurer’s Gateway desktop 
computer, running the Vista Operating System,   in a folder named Diocesan Files.  This folder is 
backed up on a daily basis to an internet QuickBooks backup server. Restoring these files from 
the internet is very time-consuming.  Thus the directory, Diocesan Files, is also copied to a USB 
Flash Drive on a weekly basis.  That USB drive is sent to the Diocesan Office and stored with 
the copy of this manual.  

In the event that the Treasurer cannot fulfill the duties of the office, the files on the USB drive 
can be copied to a PC computer and a person, appointed by the Diocesan Council and skilled in 
the use of QuickBooks, can assume those duties.  Paper files can be shipped to San Francisco by 
contacting the rector of St. Herman of Alaska Orthodox Church in Port Townsend, WA.   

Financial activity is maintained in a QuickBooks Premier Nonprofit Edition 2009 data file called 
Dowqbook.QBW.  The path for the data file is Diocesan Files/Dowqbook.QBW. The password 
for this data file may be found in the Appendix to this manual.   
 

7 FINANCIAL REPORTING POLICY 

Internal financial statements shall be prepared monthly by the Treasurer, reviewed by the 
Finance Committee, distributed to members of the Diocesan Council, and posted on the 
Diocesan website.  In order to conform to standard non-profit reporting, beginning with the third 
quarter of 2008, the financial statements shall include, at a minimum, the following: 
 

• The Statement of Financial Position (Consolidated Balance Sheet, QuickBooks classes 
all) 

• The Year-to-Date Consolidated Statement of Unrestricted Activities (P&L Statement) 
against budget. (In QuickBooks, class is "Operating" and "Outreach".) 

• The Statement of Temporarily Restricted Activities (In QuickBooks, class is "restricted") 
• The Statement of Permanently Restricted Activities (when it becomes applicable) 
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• The Statement of  Restricted Fund Balances. (Extracted from Consolidated Balance 
Sheet) 

• Report of Outstanding Parish Assessments 
 

It is the policy of this organization to use the accrual basis of accounting that recognizes 
revenues when they are earned and expenses when they are incurred. 

8 THE CHART OF ACCOUNTS 

This section lists the current chart of accounts and account descriptions.  This section may be 
amended as new accounts are added or existing accounts are made inactive.   
 

8.1 Assets 

8.1.1 Unrestricted Assets (QuickBooks Bank Accounts) 
 
Only accounts which are open at the time of the current revision are described below.  Multiple 
checking and savings accounts are indicated.  See the Attachment to this manual for account 
numbers, online user ids and passwords.  The attachment may not be posted on-line. 

 
Account Name Description 

Wells Fargo Checking 
 
 
 
 

 
Non interest-bearing disbursement account for operating 
funds.  Deposits by to this account are made by the 
Administrative Assistant and Treasurer.  The signers on the 
account are the Treasurer and Chancellor. 
 
 

Checking at Chase Noninterest-bearing disbursement account at JPMorgan 
Chase Bank.  Deposits and transfers are made to this account 
by the Treasurer.  The Treasurer and Chancellor are signers 
on the account. 

  
Unrestricted ING CDs Certificates of Deposits for unrestricted funds at ING Direct.  

See Attachment for details. 
  
Unrestricted Savings at ING Interest-bearing ING Direct Orange Business Savings account 

for unrestricted funds (http://www.business.ingdirect.com/).   
Treasurer and Chancellor may view, withdraw, and transfer 
funds. 

  
Unrestricted Savings at Wells Fargo Savings account for unrestricted or board directed funds. The 

signers on the account are the Treasurer and Chancellor.  Also 
holds funds from the sale of Point Reyes property. 

  
Savings at Chase Unrestricted short term reserves. The signers on the account 

are the Treasurer and Chancellor. 
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8.1.1.1 Policy for Opening an Asset Account  
 
Checking, Savings, and CD accounts may be opened by the treasurer after authorization by the 
Diocesan Council.  That authorization shall be documented in the minutes of the meeting of the 
Council.  The motion for authorization shall specify the signers on the account.  A minimum of 
two signers shall be designated for the account with the Chancellor of the Diocese and the 
Treasurer being signers, at a minimum.  Checks shall only require one of the signatures.  
Statements shall be downloaded on-line by the Treasurer and stored with the monthly financial 
records after the account has been reconciled. 

8.1.1.2 Account Balance Policy 
 
No single account shall have a balance in excess of the FDIC insured limit ($250,000 in 2009) 
for any extended period of time.  The Treasurer shall consult with the Finance Committee as to 
whether new accounts should be opened and how funds should be allocated among the accounts. 

8.1.1.3 Clearing Account Policy 
 
Clearing accounts within the checking account shall be funded from the appropriate temporarily 
restricted fund when funds must be disbursed by check.  These accounts should be zero at the 
end of each month. 
 

8.1.2 Accounts Receivable 
 

Account Name Description 
  
Assessment Receivables Receivables due the Diocese for Assessments 

  
Assessment Receivables:Assembly 
Assessments 

Receivables due the Diocese from parishes for 
Assessments for the Diocesan Assembly 

  
Assessment Receivables:Diocesan 
Percentage Assessment 

Receivables due the Diocese from parishes for the 
Diocesan Percentage Assessment (DPA) 

  
Assessment Receivables:Fair Share 
Assessments 

Receivables due the Diocese for the payment of parish 
Fair Share Assessments to the Orthodox Church in 
America 

  
Life Giving Spring Loan Interest-Free loan made to the Life Giving Spring Retreat 

Center in July 2002. 

  
Loans from Pt Reyes Funds Loans made out of funds from the sale of the St. Eugene 

Hermitage property in Point Reyes 
 

Loan to St. Mary Magdalene principal and accumulated interest from August 2009 
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Orthodox Mission in Merced, CA Loan at 9% interest. 
 

Loan to Holy Assumption 
Monastery, Calistoga, CA 

July 2009 no interest loan  
 
 

LGS Ongoing Operations Tracks loans to LifeGiving Spring Retreat Center from 
March 2009 until sale of property. 
 

Monastery of St John of Shanghai March 2009 no interest loan to monastery 
 
 

Misc. Receivables Receivables from individuals due the Diocese for the 
repayment of personal items inadvertently charged to 
Diocesan Credit Card.   

  
Other Parish Receivables Non-Assessment receivables due the Diocese from 

parishes.    

Portrait of American Saints Receivables Receivables due the Diocese for the sale of the booklet 
“Portrait of American Saints” 

  
Stewardship Pledges Pledges due the Diocese for Stewards of the West Pledges 

 

8.1.2.1 Policy for Determining Parish Assembly Assessments 
 

The Diocesan Assembly is normally held once a year in October.  The location of the Diocesan 
Assembly is rotated among the Deaneries of the Diocese.  Parish Assembly Assessments should 
cover the cost of the assembly to the Diocese.  The cost to the Diocese does not include the travel 
and lodging of parish delegates.  The latter is the responsibility of the individual parish.  The cost 
of the assembly to the Diocese shall be divided by the total number of parish members reported 
for Fair Share purposes on September 1 of the prior year.  Mission Stations, monasteries, and 
Institutions of the Diocese do not pay an assembly assessment.  

 

8.1.2.2 Policy for Determining Parish Diocesan Percentage Assessment (Rev. 10 Oct 2002) 
 
Purpose 
 
The purpose of this policy revision is to define the method of computing the parish Diocesan 
Percentage Assessment (DPA) and to redefine the factors that enter into what is the basis for that 
computation. 
 
Reference  
 
A Review of the Percentage Assessment Program, Diocese of the West, Orthodox Church in 
America, 
 

December 18, 1998 
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Background 
 
The Diocesan Bishop is the hierarchical authority over all the parish communities within his 
jurisdiction.  Each of the communities is a separate legal corporation and is responsible for the 
management of its own finances.  In addition, each parish is expected to contribute to the 
financial support of the Bishop and the work of the Diocese.   
 
According to the Diocesan Bylaws, each parish must submit an annual financial report to the 
Diocese.  The Diocesan Treasurer uses this report and other information to determine the amount 
of the parish assessment.  The Diocesan Percentage Assessment is the primary means of 
financing the activities of the Diocesan Bishop and those who assist him with his responsibilities.  
This policy replaces the policy and related amendments enacted by the Diocesan Assembly from 
1982 through 1998.   
 
Formula for the Computation 
 
The total DPA for a parish for the current year shall be 9% of the average of the parish net 
income and expenses as derived from the previous year’s annual report.   The parish shall pay the 
annual DPA in monthly installments.  Each installment is one-twelfth of the annual amount, 
rounded to the nearest multiple of .05.   The average of income and expenses was selected 
instead of just income in order to reduce the fluctuation of DPA from year to year.   
 
Deriving the Net Income and Expenses 
 
The Diocesan Treasurer shall begin computing the assessment by recording the parish gross 
income and gross expenses figures from the parish annual report that covers the previous 
calendar year.   
 
The Diocesan Treasurer shall next subtract the following items from gross income and expenses:  
Donor-restricted income and associated expenditures, pass-through income and expenses, Fair 
Share, DPA, and Diocesan Assembly assessments received in the report year.  Charity expenses 
are subtracted from both the gross income and expenses.   
 
Mortgage payments from capital campaign funds for the primary place of worship as well as rent 
for such space shall also be deducted from gross income and expenses in order to encourage 
church growth.  
 
The following are not deducted:  All American Council (AAC) assessments and bequests that do 
not specify a particular use.  Deducting the AAC assessment would cause a large reduction in 
Diocesan income each year in which an AAC is held. 
 
Full or Partial Exemptions from the DPA 
 

• 75% exemption – during the first year a mission community or station becomes a mission 
and/or receives an assigned priest 
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• 50% exemption – the second year after a mission community or station becomes a 
mission with an assigned priest 

• 25% exemption – the third year after a mission community or station becomes a mission 
with an assigned priest 

 
Parishes, Mission Communities, Mission Stations with 10 or fewer members are eligible for full 
exemption.  The Diocesan Council is authorized to approve further exemptions from Diocesan 
assessments based on parish income and expenses.  Parishes requesting such an exemption must 
apply in writing to the Diocesan Council.  The full DPA is due until any reduction is authorized 
by the Diocesan Council.   
 
Delinquent Payments 
 
The Diocesan Treasurer shall include in the Monthly Treasurer’s Report those parishes with 
outstanding assessments.  It is the responsibility of the Deans to monitor this report and take 
appropriate action when parishes are 60 days or more behind in their assessment payments.   
 
Definitions  
 
Parish Annual Financial Report – this report shall include either an income or cash flow 
statement for all funds as well as a balance sheet. 
 
Income Statement – This report shall list all sources and uses of cash in a fund and totals the 
category amounts for the year.  The clergy compensation category must be itemized to show 
salary, housing, medical insurance, life insurance, pension, and miscellaneous for each clergy 
paid by the parish. 
 
Balance Sheet – the balance sheet as a minimum shall show the balances of all bank accounts, 
investment instruments, and property market values.   It should also show amounts owed.   
 
Restricted Funds – funds that hold monies legally restricted by donors as to their disbursement.    
The donor legally restricts a donation by indicating on the check or envelope a restricted fund or 
item that is to receive the donation.   
 
Pass Through Monies – collections that are completely disbursed in the same calendar year.   
The disbursements do not result in a material benefit to the parish.  
 

8.1.2.3 Policy on Invoicing Parishes for the Fair Share Assessment 
 

The Orthodox Church in America (TOCA) determines the Fair Share Assessment due from 
diocesan parishes by determining what percentage of its budget the diocese as a whole must 
support.  The percentage is based on the total number of members reported by diocesan parishes.  
The Orthodox Church in America computes the amount of the assessment owed by the Diocese 
for the following year.   
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The Diocesan Council determines how the annual assessment owed to TOCA will be allocated 
among its parishes.  The current allocation is determined by the number of parish members 
reported to TOCA.  A “per member” amount to be paid by parishes is then voted upon at a 
Diocesan Council meeting.   

The Treasurer invoices each parish monthly at 1/12 of the parish “per member” amount.  The 
membership of mission stations and missions with 10 or fewer members is not reported to 
TOCA.  The latter parishes, as well as others determined by the Director of Missions, are not 
invoiced for the Fair Share Assessment. 

If a parish cannot immediately pay both monthly assessments, the Fair Share assessment shall 
have priority over the Diocesan Percentage Assessment. 

8.1.2.4 Loans to Parishes or Institutions 
 
Only the Diocesan Council may authorize a loan from Diocesan unrestricted funds to a parish or 
Diocesan Institution. 
 

8.1.2.5 Policy on Personal Expenses Charged on Diocesan American Express Card 
 
The Diocese acknowledges that occasionally air fare and/or car rental charges for personal travel 
may inadvertently be charged to the Diocesan American Express Card by an authorized user of 
the card.  The Treasurer will invoice that person for the amount charged in error. 
 

8.1.3 Other Current Assets (Inventory) 
 

Account Name Description 
  
“Saints of America” Inventory Value of the current physical inventory of the booklet “Portrait 

of American Saints” 
  

 

8.1.4 Other Current Assets (Unrestricted Cash) 
 

Account Name Description 
  
Petty Cash  The amount of Petty Cash provided to the Diocesan Office in 

San Francisco for which no expense receipts have yet been 
received.   

  
Undeposited Funds The Value of checks recorded as income but not yet deposited 

into the checking account.   
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8.1.4.1 Petty Cash Policy 
 
It is the policy of the Diocese to maintain a petty cash fund at the Diocesan Office of $200.00.  
The petty cash shall be under lock and key at all times.  Disbursements from the petty cash fund 
may only be made for budgeted and/or approved office expenditures. A receipt must accompany 
every disbursement.  The receipt must be signed by the person disbursing the reimbursement 
from petty cash and the person receiving the cash as a reimbursement.  Receipts for petty cash 
shall be submitted to the Treasurer at the end of every month. 
 
The Treasurer shall replenish the petty cash fund as needed.  The petty cash check shall be made 
out to the individual primarily responsible for maintaining the fund, with the word “agent” 
following that person’s name.   
 

8.1.5 Other Current Assets (Temporarily Restricted Assets) 

Account Name Description 
  
Mesirow Financial  Account to hold excess funds from the sale of the Point Reyes 

property in September 2007.  CDs and interest earning 
Government Trust Fund.  

  
Temporarily Restricted Assets: Mission 
Board LCBA Savings 

Interest-bearing annuity account at Loyal Christian Benefit 
Society.  Seeded from a donor directly to support Missions.  

  

8.1.5.1 Temporarily Restricted Funds Policy 
 
Funds donated to the Diocese of the West for a specific purpose shall be treated as Temporarily 
Restricted Funds if the total amount donated is expected to be disbursed for that purpose.  These 
funds are not available to the Diocese for ordinary operating expenses. 
 
If funds collected exceed the requirements of the specified purpose, then the Diocesan Council 
shall designate, if possible with donor consultation, to what purpose the remaining funds shall be 
disbursed.   
 

8.1.5.2  Board Designated Funds 
 
Savings accounts may have sub accounts for board designated funds.  They are indicated with a 
suffix of - BD. 
 

Account Name Description 
  
  
Legal Fund Set Aside - BD Board Designated Funds set aside annually from the unspent 

legal expense budget 
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Matushka Activities Set Aside - BD Board Designated Funds set aside from operating budget in 

2006 for use for Matushka activities 

  
Mission Director Salary Reserve - BD Board Designated Funds set aside for future use as salary for a 

Director of Missions. 
 

Sale of Point Reyes - BD 

Board Designated Funds set aside for the purpose of tracking 
the income and expenses from the funds from the sale of the 
property at Point Reyes, CA.  All expenses from this fund must 
have prior approval of the Diocesan Council.  

 

8.1.5.3 Board Designated Funds Policy 
 
It is the policy of the Diocese of the West to treat board-designated funds as unrestricted net 
assets on the statement of financial position.  The activity for board-designated funds will be 
included in the statement for Unrestricted Activities by Function. 
 

8.1.6 Fixed Assets (Land and Buildings) 
.   

Account Name Description 
  
Accum Depr - Vehicles Accumulated depreciation on vehicles 
  
Accum Depr - Leasehold Imps Accumulated depreciation on leasehold improvements 
  
Accum Depr - Building Accumulated depreciation on buildings 
  
Accum Depr - Furn and Equip Accumulated depreciation on furniture and equipment 
Vehicles Business automobiles and trucks, registered in the name of the 

business 
  
720 Duboce House  Shows equity in the San Francisco property as a result of paying 

off the mortgage for a now defunct parish. 
 

Life-Giving Spring Retreat Center Shows equity in the Boulder, Colorado facility as a result of 
paying off part of its debt. 

  
Facility Construction Costs of building new facilities for use while construction is still 

going on 
  
Buildings - Operating Buildings owned for current use 
  
Furniture and Equipment Capitalized and depreciable equipment, including capitalized 

repairs and improvements, costing in excess of $1,000 
individually.  Furniture and equipment for use in the Diocesan 
Office. Useful life exceeds one year 
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8.2 Liabilities 

8.2.1 Accounts Payable 
 
 

Account Name Description 
  
Accounts Payable Accrued obligations due to the Diocese’s vendors 
  
Credit Card at Chase Accrued obligations  to Chase Credit Card  

 

8.2.1.1 Policy on the use of the Diocesan Credit Cards 
 
The Diocesan Council shall designate the authorized users of the Diocesan American Express 
Cards. 
 
Authorized users of the American Express Card shall submit receipts for all expenses over 
$25.00 charged to the American Express Card.   
 
The Treasurer shall send each authorized user a copy of their statement and request verification 
and classification of the charges and the forwarding of all outstanding receipts.   
 
The Treasurer shall notify the cardholder of any missing receipts.  If receipts have been lost, then 
the Treasurer shall note this on the American Express Statement next to the charge and attach 
any email stating that the receipt has been lost.   
 
All receipts will be attached to the statement and stored with the financial records for the billing 
month. 
 

8.2.1.2 Policy on the payment of vendor 
 
The Treasurer shall enter all routine invoices into QuickBooks when received.  These invoices 
shall be paid by the due date.   
 
The Diocesan Council must approve all unbudgeted expenses before they are incurred.   
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8.2.2 Other Current Liabilities 
 

Account Name Description 
  
Direct Deposit Liabilities Obligation accrued to the Diocese when a direct deposit of 

payroll has been scheduled.   Obligation is paid when the 
scheduled payment has been made to the employee’s bank 
account. 

  
Payroll Liabilities Obligations due to outside agencies for funds withheld 

from payroll 
  
Payroll Liabilities:Federal Withholding Obligation to IRS of withheld  Federal Income Tax 

  
Payroll Liabilities:Medicare Obligation to IRS of withheld Medicare Taxes.  Only 

applicable for non-clergy employees 
  
Payroll Liabilities:Medicare:Company Obligation to IRS of Employer Match of Medicare Tax 

withheld from employee. 
  
Payroll Liabilities:Medicare:Employee Obligation to IRS of Medicare Taxes withheld from 

employee payroll. 
  
Payroll Liabilities:OCAPEN Obligation to the OCA Pension Fund of withheld and 

deferred income. 
  
Payroll Liabilities:OCAPEN:Company Obligation to the OCA Pension Fund for Mandatory 

employer contributions. 
  
Payroll Liabilities:OCAPEN:Employee Obligation to the OCA Pension Fund for the employee 

contributions withheld from pay. 
  
PayrollLiabilities: OCAPEN: Employee: 
Bishop's Contribution 

Obligation to the OCA Pension Fund for the Bishop’s 
contributions withheld from pay 

  
Payroll Liabilities:OCAPEN:Employee:Mission 
Director Contribution 

Obligation to the OCA Pension Fund for the Mission 
Director’s contributions withheld from pay 

  
Payroll Liabilities:Social Security Obligation to the IRS for Social Security Taxes (Only 

applicable for non-clergy employees) 

  
Payroll Liabilities:Social Security:Company Obligation to the IRS for the Company match of withheld 

employee social security. 

  
Payroll Liabilities:Social Security:Employee Obligation to the IRS for Social Security withheld from 

Employee pay. 
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Account Name Description 
Payroll Liabilities:State Withholding CA Obligation due to the State of California for withheld state 

income taxes   
 

Chancellor Pension Withholding Obligation due to the OCA Pension Fund from 
withholding pension contributions from the Chancellor's 
stipend.  Contribution is made exclusively by the 
Chancellor. 

 

8.2.2.1 Policy on the classification of clergy as employees 
 
Ordained clergy shall be considered as employee for Federal Income Tax purposes.  Ordained 
clergy shall be issued W2 forms if any portion of their compensation is not a housing allowance.  
The withholding of Federal or State Income Taxes is voluntary on the part of both the parish and 
the clergy.  W4 forms must be submitted annually in order for the Treasurer to withhold these 
taxes.  The Treasurer shall not withhold Medicare or Social Security taxes from the pay of clergy 
employees, nor shall the parish be obligated to pay the company portion of these taxes. 
 
If voluntary withholding of income taxes is to be performed, income taxes should not be 
computed on the housing allowance portion of clergy compensation. 
 

8.2.2.2 Policy on participation in the OCA Pension Plan (TBD) 
 

8.3 Net Assets  
Currently this terminology is not being used on financial statements, since it is not clear how Net 
Assets are implemented in QuickBooks.   
 

Account Name Description 
  
Retained Operating Earnings Cumulative result of Operations 

  
Unrestricted Net Assets Similar to Retained Earnings in commercial organizations, 

i.e. the cumulative result of operations.   Unrestricted Net 
Assets are subject to creditor action. 

  
Temporarily Restricted Net Assets Funds, received for a designated purpose, which have not 

yet been expended. 
  
Permanently Restricted Net Assets Funds received for a designated purpose, but only the 

investment earnings may be used for that purpose.    The 
investment earnings are classified at Temporarily 
Restricted Net Assets until they are expended 
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8.4 Income 

Account Name Description 
  
Lights-on Income Income to support the general operations of the Diocese  
  
Lights-on Income:Assembly Income Parish Assembly Assessment Income and Observer Fees 

Lights-on Income:Book Sales Sales of Portrait of American Saints Booklet 
  

Lights-on Income:Fair Share from Parishes Fair Share income from Parishes 

  
Lights-on Income:DPA Diocesan Percentage Assessment Income 

  
Lights-on Income:Operating Investment 
Income 

Dividends & Interest Earned by unrestricted fund  

  
Lights-on Income:Reimbursed Returned Check 
Charges 

Income from parish to refund cost to the Diocese of their 
returned check 

  
  

Outreach (Stewards of the West) 
Income from Stewards of the West donations and pledges 
to support outreach programs 

  
Outreach (Stewards of the West):General 
Stewardship Donations 

Stewards of the West Donations  

  
Outreach (Stewards of the West):Pledges Income from Pledges to Stewards of the West 

  
  
Restricted Income Temporarily Restricted Income 

 
Restricted Income:Direct Charity Temporarily Restricted Income directed to a particular 

charitable purpose. 

Restricted Income:Liturgical Fund Income Temporarily Restricted Income for Liturgical Items 

Restricted Income:Mission Board Income Temporarily Restricted Income for Missions 
  
Restricted Income:Mission Board 
Income:Donations for Missions 

Donations for Missions 

  
Restricted Income:Mission Board 
Income:Mission Board Funds Annuity Int 

LCBA annuity fund interest on Missions Fund 

  
Restricted Income:Mission Board Income:St. 
Andrew Distributrion 

Income from OCA from the St. Andrew Fund 

  
Restricted Income:Music Department Temporarily Restricted income directed to the Music 

Department  
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8.4.1 Policy on Receipt of Funds 
All invoice payments and donations should be mailed to the Diocesan Office in San Francisco.   

All checks received in the mail shall be immediately endorsed.   See procedure in Section 10 for 
processing receipts. 

 

8.5 Expenses 

8.5.1 Lights on Expenses – Wages (Clergy & Non-Clergy W2 Employees) 
 

Account Name Description 
  
Lights-on Expenses:Payroll Expenses:Gross Wages Gross Wages and housing allowance for employees 

working at the Diocesan Office in San Francisco 
  
  
 (Other sub-accounts of Gross Wages are created as 
needed for additional employees)  

 

8.5.1.1 Policy on Classification of Clergy as Employees 
 
Ordained clergy, who work in the Office of the Diocese of the West in San Francisco, shall be 
considered employees for Federal Income Tax purposes.  See Section 14.7.3 for instructions on 
how to prepare their Form W2. 

8.5.1.2 Policy on Classification of Non-Clergy as Employees 
 
Non-clergy, who are hired to work in the Office of the Diocese of the West in San Francisco, 
shall be considered regular exempt employees.  They shall be issued a hiring contract and 
provided with a list of their roles and responsibilities.  See Section 14.7.3 for instructions on how 
to prepare their Form W2. 
 

8.5.2 Lights on Expenses – Stipends (Clergy & non-Clergy Self-Employed Status) 
 

Account Name Description 
  
Lights-on Expenses:Payroll Expenses: Stipends Stipends paid to clergy and non-clergy workers who 

report or will report this income to the IRS as self-
employment income.  This includes the Chancellor, 
Deans, and Treasurer 
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8.5.2.1 Policy on Classifying a Diocesan Worker as Self-Employed 
 
When a person is appointed or elected to fill a paid position with the Diocese of the West, that 
person shall declare in writing to the Treasurer that they will report this income to the IRS as 
self-employment income.  They will receive a Form 1099 and the stipend will be reported as 
Non-Employee Compensation. 
 
If that person will not be reporting their income as self-employment income, they will be 
considered employees of the Diocese of the West and issued a Form W2 instead. 
 
In addition, the Bishop of the Diocese or a member of the Finance Committee shall use the 
following criteria to confirm the status of a worker as self-employed and inform the Treasurer as 
to the correct status to be applied. 
 

Common Law Employee Test:  “Workers are subject to the control of the Bishop and/or 
the Diocesan Council only as to the result to be accomplished and not as to the means and 
methods for accomplishing the result.” 
 
IRS 20-Factor Test: The majority of the answers to the questions for those receiving 
mission stipends, stipends as Deans,  or other self-employed Diocesan workers should 
fall into the SE column. 

 

8.5.3 Lights on Expenses – Employee Benefits 
 

Account Name Description 
  
Lights-on Expenses:Payroll Expenses:Employee 
Benefits 

Clergy and Non-clergy Employee Benefits paid by the 
Diocese of the West.   

  
Lights-on Expenses:Payroll Expenses:Employee 
Benefits:Diocesan Hierarch Benefits 

Diocesan Hierarch Benefits paid by the Diocese  

  
Lights-on Expenses:Payroll Expenses:Employee 
Benefits:Diocesan Hierarch Benefits:Health 
Insurance 

Self -Explanatory 

  
Lights-on Expenses:Payroll Expenses:Employee 
Benefits:Diocesan Hierarch Benefits:OCA Life 
Insurance 

Self-Explanatory 

  
Lights-on Expenses:Payroll Expenses:Employee 
Benefits:Diocesan Hierarch Benefits:OCA Pension 

Mandatory Diocesan contribution (6% of 
compensation) paid to the OCA Pension Plan. 
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8.5.4 Lights on Expenses – Payroll Taxes and Other Payroll Expenses 
 

Account Name Description 
  
Lights-on Expenses:Payroll Expenses:Payroll 
Taxes:Medicare Taxes 

Medicare Taxes – Diocesan Share 

  
Lights-on Expenses:Payroll Expenses:Payroll 
Taxes:Social Security Tax 

Social Security Taxes – Diocesan Share 

  
Lights-on Expenses:Payroll Expenses:Penalties & 
Interest 

Obligation due IRS for any late payment of 
withholding taxes 

  
Lights-on Expenses:Payroll Expenses:Direct Deposit 
Fees 

Fees for QuickBooks Direct Deposit of employee 
paychecks to bank account. 

  
Lights-on Expenses:Payroll Expenses: Workman's 
Comp Workmans Compensation Insurance Paid by Diocese 

 
The Diocese shall pay Medicare and Social Security Taxes for non-clergy employees only. 
 

8.5.5 Lights on Expenses – Professional Fees 
 

Account Name Description 
  
Lights-on Expenses:Professional Fees:CPA Fees Fees paid to CPAs for Financial Reviews and Advice 

 
Lights-on Expenses:Professional Fees:Legal Fees Fees paid to Lawyers and Law Firms 

 
Lights-on Expenses:Professional Fees:Notary Public  Fees paid to Notary Public 

 
Lights-on Expenses:Professional Fees: Investment 
Fees 

Fees paid to investment managers 

  

8.5.5.1 Policy on Payment of Invoices for Professional Fees 
 
The Treasurer shall pay invoices for fees that have been budgeted or for fees that have been 
approved by the Diocesan Council prior to the incurring of the fee for services. 
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8.5.6 Lights on Expenses – Office Expenses and Supplies 
 

Account Name Description 
  
Lights-on Expenses:Office Expenses:Books & 
Publications 

Disbursements for business-related books and 
publications. 

  
Lights-on Expenses:Office Expenses:Bank Charges Bank Charges for Returned Checks and Online 

Banking through QuickBooks 
 

Lights-on Expenses:Office Expenses:CA Non-Profit 
Filing Fee 

Filing Fee paid to California to update non-profit 
status. Due every 2 years. 
 

Lights-on Expenses:Office Expenses:Church Tax & 
Law Subscriptions 

Subscriptions to Church & Tax Law, Treasurer Alert 
bulletins and on-line access to same information.  
 

Lights-on Expenses:Office Expenses:Fort Ross 
Registration 

Registration Fee for use of Fort Ross Chapel and 
Grounds for Fourth of July Annual Celebration 
 

Lights-on Expenses:Office Expenses:OCA Liturgical 
Donation 

Payment of Obligation to OCA for Liturgical Items 
supplied to Dioceses.   (Usually billed annually) 
 

Lights-on Expenses:Office Expenses:Office 
Equipment 

Disbursement for office equipment not capitalized.  
(Under $1,000) 

  
Lights-on Expenses:Office Expenses:Office Supplies 
& Expenses 

Disbursement for consumables not qualifying for 
capitalization. 
 

Lights-on Expenses:Office Expenses:Postage Disbursements for postage to Post Office, Fed Ex, 
Stamps.com 

  
Lights-on Expenses:Office Expenses:Postage: Bulk 
Fee 

Fee paid for Bulk Third Class Postal Permit 
 
 

Lights-on Expenses:Office Expenses:Telephone Office and Cell Phone expenses 
 

Lights-on Expenses:Office Expenses:Telephone: 
Diocesan Hierarch Cell Phone 

Telephone Expenses paid to Verizon for cell phone 
and internet access 

  
  

 

8.5.6.1 Policy on Payment of Expenses for Office Supplies 
 
Disbursements may be made by the Treasurer for Office Supplies that are accompanied by a 
receipt.    If the supplies are purchased with the Diocesan America Express Card, the purchaser 
must send the receipt to the Treasurer, otherwise, the purchaser will be invoiced by the Diocese 
for the expense. 
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8.5.7 Lights on Expenses – Travel 
 

Account Name Description 
  
Lights-on Expenses:Travel:Travel for Auditing 
Function 

Disbursements paid for transportation, food, and lodging  
of Internal Auditors and Treasurer 

  
Lights-on Expenses:Travel:All American Council Disbursements paid for transportation, food, and lodging 

for the Bishop to attend the All American Council. 
  
Lights-on Expenses:Travel:Chancellor's Advisory 
Committee 

Disbursements paid for transportation, food, and lodging 
for the members of the Chancellor’s Advisory Committee 
to attend meetings. 

  
Lights-on Expenses:Travel:Chancellor's Travel Disbursements paid for transportation, food, and lodging 

for the Chancellor to perform duties assigned by the 
Bishop 

  
Lights-on Expenses:Travel:Council Meeting Travel Disbursements paid for transportation, food, and lodging 

for the members of the Diocesan Council, and occasionally 
Deans, to attend a Diocesan Council Meeting. 

  
Lights-on Expenses:Travel:Dean's Travel Disbursements paid for transportation, food, and lodging 

for the Deans to attend a meeting of the Deans.  Also covers 
a Dean’s travel within his Deanery if approved by the 
Bishop.  

  
Lights-on Expenses:Travel:Diocesan Hierarch Travel Disbursements paid for transportation, food, and lodging 

for the Diocesan Hierarch for parish visits and Pan 
Orthodox meetings. 

  
Lights-on Expenses:Travel:Metropolitan Council Disbursements paid for transportation, food, and lodging 

for the Diocesan representatives to the Metropolitan 
Council to attend meetings of the Metropolitan Council 

  
Lights-on Expenses:Travel:Misc.Travel Disbursements paid for transportation, food, and lodging 

for travel by Finance Committee to meetings or by 
prospective clergy to the Diocesan Office. 

  
Lights-on Expenses:Travel:Seminary Visit Disbursements paid for transportation, food, and lodging 

for the Director of Missions and one Dean to visit OCA 
Seminaries once a year. 

 

8.5.7.1 Policy on Payment or Reimbursement for Travel 
 
The Treasurer may reimburse travelers for expenses described in the above accounts only if the 
request for reimbursement is accompanied by receipts.  Receipts are required for all expenses 
over $25.00. Receipts may be sent to the Treasurer electronically.  The Treasurer will pay travel 
expenses described in the above accounts and billed to the Diocesan Credit Card only if the 
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traveler furnishes receipts for those expenses.  Otherwise the traveler will be invoiced for Credit 
Card Charges not supported by receipts.   
 

8.5.8 Lights on Expenses – Insurance and Property Expenses 
 

Account Name Description 
  
Lights-on Expenses: Insurance and Property: 
Property & Liability Insurance 

Insurance for General Liability and St. Eugene property 

  
Lights-on Expenses: Insurance and Property :LGS 
Support 

Disbursements to Life-Giving Spring for 2009 operating 
expenses. 

Lights-on Expenses: Insurance and Property: 
Bishop's Move & Furnishings 

Expenses for Diocesan Office and Bishop Residence 
Furnishings. 

  
 

8.5.9 Lights on Expenses – Clergy and Parish Resources Expenses 
 

Account Name Description 
  
Lights-on Expenses: Clergy and Parish Resources:  
OCA Clergy Assistance Prgm. 

Annual Fee paid to OCA for Clergy access to 
counseling program 

  
Lights-on Expenses: Clergy and Parish Resources: 
Clergy Pre-Assignment Assesmt 

Expense for professional assessment of clergy prior to 
assignment within the Diocese of the West 

  
Lights-on Expenses: Clergy and Parish Resources:  
Diocesan Loan Fund Development 

Expenses to set up a Diocesan Loan Fund 

  
Lights-on Expenses: Clergy and Parish Resources: 
Liturgical Supplies 

Expenses for Liturgical Supplies requested by Bishop 
for use at parishes and missions 

  

8.5.10 Lights on Expenses – OCA Expenses 
 

Account Name Description 
  
Lights-on Expenses:OCA Expenses: Fair Share 
Paid to OCA 

Parish Fair Share paid to OCA 

  
Lights-on Expenses:OCA Expenses: All 
American Council Assessment 

OCA assessment for the All American Council  
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8.5.11 Lights-on Expenses -  Department of Communications 
 

Account Name Description 
Lights-on Expenses:Department of 
Communications:”Saints of America” 
Publication 

Expenses for the publishing of an edition of the Portraits of 
American Saints booklet.   

  
Lights-on Expenses:Department of 
Communications:Publication Editor Stipend 

Payment of Stipend to Editor of the Vision for each issue of 
the Vision 

  
Lights-on Expenses:Department of 
Communications:Publication Office Supplies 

Expenses for office supplies of Department 

  
Lights-on Expenses:Department of 
Communications:Publishing & Mailing 

Expenses for the publishing and mailing of the Vision 
Magazine 

  
Lights-on Expenses:Department of 
Communications:Web Site Service Provider 

Annual expense for provider of web site server and 
services 

  
Lights-on Expenses:Department of 
Communications:Web Site Designer Stipend 

Stipend paid to designer and maintainer of Diocesan Web 
Site. 

  
 

8.5.11.1 Policy on Payment of Department of Communications Expenses 
 
Office expenses, Vision publication expenses, and Web Site provider receipts and/or invoices 
must be presented by the Chair of the Department of Communications to the Treasurer for 
payment.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v5.00 
  
 

Page 28 of 93 

8.5.12 Lights-on Expenses - Diocesan Assembly 
 

Account Name Description 
  
Lights-on Expenses:Diocesan 
Assembly:Security 

Self-Explanatory 

  
Lights-on Expenses:Diocesan Assembly:Airfare Expenses for airfare to the assembly for Guests of the 

Diocese.    
  
Lights-on Expenses:Diocesan Assembly:Badge 
Holders & Nametags Self-Explanatory 
  
Lights-on Expenses:Diocesan Assembly: 
Banquet 

Self-Explanatory 

  
Lights-on Expenses:Diocesan Assembly:Food Self-Explanatory 
  
Lights-on Expenses:Diocesan Assembly: 
Honorarium 

Self-Explanatory 

  
Lights-on Expenses:Diocesan Assembly:Postage Expense of postage for mailing the Assembly 

Announcement and Registration Materials. 
 

Lights-on Expenses:Diocesan Assembly: 
Projection System Self-Explanatory 
  
Lights-on Expenses:Diocesan Assembly: 
Transportation 

Expenses of the hosting parish to transport guests to the 
assembly. 

  

8.5.12.1 Policy on Diocesan Assembly Expenses 
 
Parishes are responsible for the payment of transportation and lodging of their delegates to the 
Diocesan Assembly. 
 
Delegates make their own hotel and transportation reservations. 
 
Non-clergy members of the Diocesan Council will be reimbursed for transportation and lodging 
for the Diocesan Assembly. 
 
The hosting parish shall submit receipts for expenses incurred for hosting the Assembly. 
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8.5.13 Outreach Expenses - Department of Missions – Unrestricted Expenses 
 

Account Name Description 
  
Outreach Expenses:Department of 
Missions:Mission Assistance 

Expenses for supplies for a Mission or Mission Station 

Outreach Expenses:Department of 
Missions:Director Assistant Stipend 

Stipend payable to the Assistant to the Director of Missions 
 

Outreach Expenses: Department of Missions: 
Mission Board Meeting Expenses 

Self explanatory 

Outreach Expenses:Department of 
Missions:Mission Dept Travel 

Transportation, Lodging, and Food expenses incurred by 
the Director of Missions when visiting Mission parishes. 

Outreach Expenses:Department of Missions: 
Mission Dir Housing Allowance 

Housing Allowance paid to the Director of Missions 

Outreach Expenses:Department of Missions: 
OCA Pension – Mission Dir 

Diocesan Contribution to Mission Director Pension 

  
Outreach Expenses:Department of 
Missions:Supplement to Director’s Parish 

Payment to Mission Director’s parish for Director’s time 
away from parish. 

Outreach Expenses:Department of 
Missions:Moving Expenses 

Relocation expenses for a new priest to a mission.  

  
Outreach Expenses:Department of 
Missions:Stipends for Mission Priests 

Stipends paid to specified mission priests to supplement 
their income until parish can fully support them.   

8.5.13.1 Policy on Stipend Payments to Mission Priests 
 
The Mission Board shall determine which mission priests shall receive stipends, the amount of 
the stipend, and the length of time for the stipend. 
 
The Director of Mission (Mission Dean) makes stipend recommendation to the Mission Board 
when a priest comes into a mission setting.  Stipend amounts are $400 for the first year, $300 
second year, $200 next, and $100 the following year.  The Mission Dean holds discussion with 
the priest and MB for any extensions beyond that period of time.  Stipends may be suspended by 
the Mission Dean at any time if they are no longer needed or appropriate.   
 
The Mission Dean shall submit a budget request for stipends and other Department of Mission 
Expenses to the Diocesan Budget Committee for the following year.   The Mission Dean is not 
required to ask for Diocesan Council approval of the manner of distribution of the stipends.  If 
the amount budgeted for stipends is insufficient, then the Mission Dean must request the increase 
from the Diocesan Council.    
 
The Mission Dean shall provide the Treasurer of the Diocese with a current list of those priests 
who are receiving stipends and the dates when those stipends shall change or cease.  The Mission 
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Dean shall provide the Treasurer with current contact information for all priests receiving 
stipends. 
 

8.5.13.2 Policy on Payment of Department of Missions Expenses 
 
The Treasurer may disburse funds for Mission Department Travel substantiated by receipts and 
within the approved budget.   Written requests for payment of unbudgeted expenses by the 
Director of Missions will be accepted.  The Director of Missions is expected to manage the 
budget for Missions.  Those expenses will be paid as long as there are no budget over-runs.    
 

8.5.13.3 Policy on Source of Funds to Pay Expenses 
 
The above expenses shall be routinely paid from budgeted unrestricted funds.  They will not be 
paid out of the Temporarily Restricted Missions Funds in the LCBA annuity account or the 
Chase savings account. 
 

8.5.14 Outreach Expenses – Charities Department – Unrestricted Expenses 
 

Account Name Description 
  
Outreach Expenses:Department of 
Charities:Clergy Assistance 

Expenses directed to be paid by the Chairman of the 
Department of Charities. 

Outreach Expenses:Department of 
Charities:Discretionary Fund 

Expenses directed to be paid by the Chairman of the 
Department of Charities. 

Outreach Expenses:Department of 
Charities:Eritrean Home for Elderly 

Diocesan Donations to the Gobezie Goshu Home 

  
Outreach Expenses:Department of 
Charities:Martha-Mary House 

Diocesan Donations to the Martha-Mary House 

  
Outreach Expenses:Department of 
Charities:Raphael House (Portland) 

Diocesan Donations to Raphael House in Portland 

  
Outreach Expenses:Department of 
Charities:Raphael House (SF) 

Diocesan Donations to Raphael House in San Francisco 
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8.5.14.1 Policy on Management of Charities Department Budget and Expenses 
 
The Charities Department shall submit a budget to the Diocesan Finance Committee for charities 
and institutions to be supported by the Diocese out of unrestricted funds.  The Charities 
Department shall approve all disbursements to individuals and shall submit such approval to the 
Treasurer prior to the payment of any expenses for that individual or the writing of any check to 
that individual. 

8.5.15 Outreach Expenses – Youth – Unrestricted Expenses 
 

Account Name Description 
  
Outreach Expenses:Youth Expenses for youth and youth retreats by Deanery   

 

8.5.15.1 Policy on Payment of Expenses for Youth 
 
The payout of allocated funds for youth by Deanery is based upon the request of the Dean with 
the approval of the Director of Youth.    Deanery specific and Non-Deanery specific youth 
expenses are managed to budget by the Director of Youth.   
 

8.5.16 Outreach Expenses – Department of Stewardship - Unrestricted Expenses 
 

Account Name Description 
  
Outreach Expenses:Department of 
Stewardship:Online Donation Fees 

Fee to PayPal for Donations received from Diocesan Web 
Site 

Outreach Expenses:Department of 
Stewardship:Paper & Copying 

Expenses for the paper and copying charges, envelopes, 
and labels for mailing two appeals per year. 

Outreach Expenses:Department of 
Stewardship:Postage for Appeals  

Postage expenses for the mailing of the appeals and 
responses to donations. 

Outreach Expenses:Department of 
Stewardship:Stewardship Director 

Stipend or Wages for Director of Stewardship.  Position is 
currently vacant 

Outreach Expenses:Department of 
Stewardship:Travel 

Transportation, lodging, and food expenses for Director of 
Stewardship 

  
 

8.5.16.1 Policy on Payment of Expenses for Appeals 
 
The Treasurer shall reimburse all substantiated expenses for the mailing of appeals  
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8.5.17 Outreach Expenses – Miscellaneous Outreach Expenses - Unrestricted Expenses 
 

Account Name Description 
  
Outreach Expenses:Department of Education Self-Explanatory 
  
Outreach Expenses:Music Dept Self-Explanatory 
  
Outreach Expenses:Seminarian Financial Aid Self-Explanatory 
  
Outreach Expenses:Matushki Activities Self-Explanatory 
  
Outreach Expenses:Uncollectable Pledges Self-Explanatory 
  

 

8.5.18 Expenses from Temporarily Restricted Asset Accounts 
 

Account Name Description 
  
Restricted Expenses: BD - Point Reyes Sale 
Funds 

Expenses paid out of funds received from the sale of 
property in Point Reyes, CA.  One subaccount for each gift 
from the fund. 
 

Restricted Expenses: Designated Direct 
Charities 

Disbursement for donor designated charity.  One expense 
subaccount per specified charity. 

Restricted Expenses:Hermitage Expenses Disbursement for St. Eugene Hermitage Maintenance and 
new construction 

Restricted Expenses:Hermitage Expenses: 
Move and Reconstruction of Chapel 

Disbursement for moving chapel to monastery in Manton, 
CA. 

Restricted Expenses:Liturgical Items Fund 
Expense 

Disbursements for vestments for Bishop 

  
Restricted Expenses:Mission Board Expenses Disbursement for Mission Board expenses from 

Temporarily Restricted Funds 
 

Restricted Expenses:Mission Board 
Expenses:Missions Support Items 

Disbursements for Liturgical Items for Missions 

Restricted Expenses:Music Fund Expenses Disbursements from Temporarily Restricted Music Fund 

Restricted Expenses:Pass Through Expenses Disbursements for expenses that will be reimbursed  
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9 OVERVIEW OF TREASURER PROCEDURES 
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10 DAILY/WEEKLY – PROCESS INCOMING RECEIPTS 

Controls for Receipts 
Receipts are almost always in the form of a check or money order made payable to The Diocese 
of the West.  Cash is rarely received and when it is, it is a donation and the amount is less than 
$5.00.   

Parish assessment receipts and donor pledge payments are receipts against invoices.  Invoices 
and Statements are sent to parishes on a monthly basis.  Parish Treasurers are expected to review 
the statements and contact the Treasurer of the Diocese if payments have not been correctly 
credited to the parish.  Pledge statements are mailed twice a year and donors are notified when a 
pledge has been fulfilled.  The statements act as a control to mitigate the risk of checks not being 
correctly attributed and deposited.   

Stewardship donations are always acknowledged with thank you letters.  At the end of a 
stewardship year, the names of donors and their donor classification is posted in the Vision 
magazine.  The acknowledgements and the posting of donors’ names act as checks against 
donations being incorrectly recorded. 
The Administrative Assistant processes all receipts and deposits all funds.  A record of the 
receipts and deposits is passed on to the Treasurer who records the payments in QuickBooks. 

 
Overview of Administrative Assistant Role in Processing Receipts 
 
 

 
 
 
 
 
 
 

Endorse Receipts 
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Prepare & Make 
Deposits 
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Overview of Treasurer Role in Processing Receipts 
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10.1 Endorse Receipts and Record in Log 
 
Purpose of the Procedure 
To assure that all checks received by the Administrative Assistant  

• are promptly endorsed 
• are handled in a matter which will prevent theft or loss 
• are properly recorded    

Frequency 
The Administrative Assistant shall follow this procedure every day after the mail had been 
delivered. 
 
Assumption 
The Administrative Assistant  

• shall use a log file in a format supplied by the Treasurer 
• has an endorsement stamp provided by the Treasurer 
• has deposit slips provided by the Treasurer 

The log file has entries for 18 checks. 
There may be more than one log file created for a given week. 
 
Main Procedure 
 

1. Open Diocesan mail and remove checks and any accompanying notes, invoices, or 
statements. Discard the envelope if the return address is known to be correct. 

2. Open the log file for the next deposit.    

3. For each check received,  

a. Confirm the check is made payable to “The Diocese of the West”.  Any other 
designation is not acceptable to the bank 

b. Confirm that the amount in numbers is the same as the amount on the legal line. 

c. Record the information from the check and any accompanying paperwork. 
Discard accompanying paperwork, unless there is a note addressed specifically 
to the Treasurer. 

d. If this check is from an individual, confirm the name and address provided agree 
with the information in the Vision mailing list and update the mailing list, if 
necessary. 

4. Repeat from step 4 until the log file has 18 checks recorded or until it is time for a 
deposit will be prepared. 

5. Print out log file and wrap around corresponding batch of checks.  Save a soft copy of 
the log file. 

6. Store checks and any pledge cards in locked box until checks are ready to be deposited. 

End of Procedure 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v5.00 
  
 

Page 37 of 93 

10.2 Prepare and Make Deposits 
Purpose of the Procedure 
To assure that all checks received by the Administrative Assistant  

• are handled in a matter which will prevent theft or loss 
• are properly recorded    
• are deposited within one week of their receipt 

To assure that deposit information is systematically and promptly delivered to the Treasurer  
 
Frequency 
Weekly 

 
Main Procedure 
  

1. Remove all checks, log files and any pledge cards from the locked box. 
2. Select one batch of checks and the corresponding log file. 
3. Use a calculator and confirm that the total amount of the checks in one batch matches the 

amount calculated in the log file (Excel Spreadsheet) 
4. Prepare the bank deposit slips for each batch and make the deposit, requesting a receipt 

for each deposit. 
5. Initial and date the printed log files and staple the deposit receipts to the log file.  
6. Keep the copy of the bank deposit slip for your records along with a printed copy of the 

logfile.  
7. Mail the log files and deposit receipts along with any pledge cards or communications in 

an envelope to the Treasurer.   
8. Email a softcopy of each log file to the Treasurer 

 
End of Procedure 
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10.3 Record a Parish Payment  
 
Purpose 
To properly record a payment against an existing invoice 
 
Assumptions 

• The Treasurer has received the log file of deposits from the Administrative Assistant 

• The payment is for an existing invoice in QuickBooks. 

• Receivable accounts are: 
Assessment Receivables 
 Assembly Assessments 
 Diocesan Percentage Assessments 
 Fair Share Assessments 
 Prior to 2003 DPA 
 
Life Giving Spring Loan 
Other Parish Receivables 
Saints of America Receivables 
Stewardship Pledges 
Misc. Receivables 
 

Parishes that should pay Fair Share and/or Diocesan Percentage Assessments are designated by a 
numerical prefix followed by the city name.  The prefix sorts the parishes by Deanery.  Parishes 
with a 600 prefix do not have a permanent priest assigned, and those with a 700 prefix are not 
officially missions yet.  Those parishes having 600 prefixes may or may not have been required 
to pay DPA or Fair Share Assessments.   

 

The following is the list of diocesan parishes, missions, and mission stations as of the date of this 
revision:  
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100 Calhan, CO 450 Santa Barbara, CA  
100 Colorado Springs, CO 450 West Sacramento, CA 
100 Delta, CO 500 Ashland, OR 
100 Denver - Transfiguration of Christ Ca 500 Bend, OR 
100 Littleton - St. Herman's Church 500 Billings - St. Nicholas of South Canaan 
100 Pueblo, CO 500 Bozeman, MT 
200 Concord, CA 500 Chico, CA 
200 Livermore, CA 500 Eureka, CA 
200 Sacramento, CA 500 Fremont, CA 
200 San Anselmo, CA 500 Hesperia, CA 
200 San Francisco, CA 500 Kirkland, WA 
200 Santa Rosa, CA 500 Kona, HI 
200 Saratoga, CA 500 Lake Havasu City, AZ 
300 Corvallis, OR 500 Merced, CA  
300 Portland, OR 500 Milwaukie, OR 
300 Puyallup, WA 500 Palms, CA (Culver City)  
300 Seattle, WA 500 Port Townsend, WA  
400 Las Vegas, NV 500 Poulsbo, WA 
400 Los Angeles, CA 500 Redding, CA 
400 Oxnard, CA 500 Sonora, CA 
400 Phoenix, AZ 500 Tempe, AZ 
400 Poway, CA 500 Vancouver, WA  
400 Santa Maria, CA 600 Helena, MT  
400 Tarzana, CA 600 Kelso, WA  
450 Berkeley, CA 600 Spokane, WA  
450 Menlo Park, CA  
450 San Diego, CA  
450 San Francisco, CA  
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Main Procedure 
 
1. In QuickBooks, select Customers>Receive Payments if the Receive Payments window 

has not been opened. 

2. For each entry of the log file that is a payment against an assessment invoice, 

 
a) In the Received From field, enter the customer name (last name, first name) or parish 

code. 

b) If this is an assessment payment, select DPA, Fair Share, or Assembly for the 
customer job. 

c) Select the corresponding receivables account. 

d) Confirm correct date has been auto-filled.  Enter the “Amount”, Ref. /Check No., and 
“Payment Method”. 

e) In the “Memo” field, enter the assessment month(s) paid.  Indicate if this is only a 
partial payment. 

f) Credit the assessment payment to the month indicated on the check or the one that is 
automatically selected in the lower part of the Receive Payments window.   

g) If this payment is the final payment on a stewardship pledge, then make a note of this 
fact for reference when generating donation acknowledgements and pledge 
fulfillments.     

h) Select “Save & New”. 

3. Repeat from Step 2 for each payment entry on the log file. 

 
End of Procedure 
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10.4 Record Donations  
 
Purpose:   
To record the receipt of a donation and attribute it to the correct account 
 
Assumptions:   

• The donation is a donation to the Stewards of the West (SOW) donation, but not a pledge, or 
a donation in response to a Paschal or Nativity appeal. 

• Appropriate donation acknowledgment templates have been created as QuickBooks Sales 
Receipt forms. There is a form for each category described below.  The content of the 
acknowledgement has been drafted by the ruling Bishop or Chancellor.  

Background: 
 

STEWARDS OF THE WEST 
 

The Stewards of the West (SOW) is an honorary society of leading contributors to the Diocese of 
the West of the Orthodox Church in America.  The purpose of Stewards of the West is to 
appropriately recognize those who have generously supported the indispensable outreach 
missions and charitable works of the Diocese.   

 

Membership in SOW encourages meaningful and consistent charitable giving in support of 
Diocesan programs and activities and effectively sustains the Diocese in the performance of its 
God given duties.  SOW members provide the Diocese of the West with the funds necessary to 
meet the special needs of the Church throughout the western half of the United States in a way 
parish assessments alone cannot achieve. 

  

Categories of Membership 

Sustaining Member 
($100 per year) 

"Standard Bearer" 
($500 per year) 
"Torch Bearer" 

($1,000 per year) 
Lifetime "Beacon" 

($10,000 one-time gift, or 
$25,000 bequest by will, or charitable trust) 
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Procedure: 
1. From within QuickBooks, select Customer > Enter Sales Receipts, if the Enter Sales 

Receipts window has not already been opened. 

2. For each entry in the log file which is a donation,  

a) In the “Customer: Job” field of the donation acknowledgement form, enter the last 
name of the donor followed by a comma, and then the first name(s). The system will 
automatically fill in an existing customer name that matches or nearly matches what 
was entered. 

b) Based on the amount of the donation check and using the table above, select the 
appropriate template.  

c) Tab to the Class field on the sales receipt form.   

d) Enter either Stewards of the West or Nativity Donation or Paschal Donation in the 
Class field. 

e) If this donation is from a pre-existing donor, confirm that the address displayed is the 
same as that indicated on either the accompanying donation card or the check.  

f) In the empty unlabeled field, enter "Dear" followed by the appropriate greeting name 
for the donor, followed by a comma.  Enter the check number, if applicable, and the 
method of payment in the form.   

g) Select the appropriate item type.   

h) If this donation is designated to Stewards of the West and is at least $100.00, select 
the item name Stewardship/Enrollment.  If it is less than $100.00, select the item 
name Stewardship/Donation.  If this donation is designated as a Nativity donation, 
select the item name Nativity.  If this donation is a Paschal donation, select the item 
name Paschal Donation. 

i) Enter the donation amount.  Make sure that the "to be printed" box is checked. 

j) Select “Save and New”.   

3. Return to step 2 

End of Procedure 
 
Alternate Flow at Step 2a: New Donor or System does not auto-Fill in the donor name 
correctly 
 
1. Add the new donor information for the customer in the customer list.  If you update the 

address or add a new donor, you will have to re-select the customer to capture the new 
address in the Donation Thank You form.  

2. Resume at Step 2b. 
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10.5 Record Miscellaneous Payment or Check 
 
Purpose 
To record checks which are not donations or parish payments. 
 
Assumption 

• Merchandise, other invoice items, or pass through items have already been created in the 
Item List in QuickBooks. 

 
Procedure: (Payments against other invoices) 
Example: Lake Havasu re-payment of legal fees. 
1. With QuickBooks open, select Customers>Receive Payments 

2. Enter the customer name in the “Received from” field. 

3. Select an appropriate “Receivables” account.   

4. Confirm that the appropriate open invoice appear in the lower window. 

5. Enter the payment information 

6. Select “Save & Close”. 

End of Procedure 
 

Procedure: Payments for Merchandise or pass through receipts 
Example: payments for posters or Saints of America Book 
Example: St. Andrew Fund payments to Mission Board 
 
1. With QuickBooks open, select Customers>Enter Sales Receipt. 

2. Select the correct Customer Name in the Customer: Job field. 

3. Select Template “Sales Receipt”. 

4. Enter Check Number and Payment Method 

5. Select the appropriate Item 

6. Enter the quantity ordered and the amount of the check. 

7. Make sure the “To be printed” box is not checked. 

8. Select “Save & Close”. 

End of Procedure 
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10.6 Recording a Stewardship Pledge 
 
Purpose:   
To record a pledge to the Stewards of the West 
 
Assumption:   

• The treasurer has received a pledge from a donor. 
 
Procedure: 
1. Select Customers>Create Invoices. 

2. Enter the donor’s name (last name, first name) in the customer: job field. 

3. Enter the class “Pledge”. 

4. Select the Accounts Receivable account,  Stewardship Pledges 

5. Select the template, Stewardship Pledge.  “Confirmation of Pledge” will replace the word 
“Invoice”. 

6. Enter a letter-style greeting (Dear ……) in the blank box under today’s date on the 
Confirmation of Pledge form. 

7. On the pledge form, enter the last pledge payment date, i.e. 8/15/2006. (The pledge 
period concludes before the Diocesan Assembly in order to facilitate recognition) 

8. Enter the donation type, i.e. SOW Pledge, the terms of the pledge and the pledge amount, 
for example:  Pledge to Stewards of the West - $100.00 annually. 

9. Select the customer message “Thank you for your pledge to the Stewards of the West”. 

10. Check the “to be printed” box. 

11. Save and close the form. 

12. Select Print Forms>Invoices with A/R account set to Receivables:Stewardship Pledges. 

13. Print Pledge Confirmation on plain paper. 

14. Sign the Confirmation of Pledge letter. 

15. Return to step 3 of the Endorse and Sort Receipts procedure. 

End of Procedure 
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10.7 Record Deposit in QuickBooks 
 
Purpose 
To create a deposit equivalent to the actual bank deposit made by the Administrative Assistant. 
 
Assumptions 

• Administrative Assistant has forwarded the log file and deposit receipt 
 
Frequency 
This procedure should be followed for each log file received. 
 
Main Procedure 
1. Open QuickBooks. 

2. For Each log file, 

a) Select  Banking>Make Deposits 

b) Click on the checks and any cash recorded in this log file.  Click on OK. 

c) In the next window, enter the date on which the deposit was made.  Confirm the 
correct account is displayed in the “Deposit to” field.  Directed donations should be 
deposited to the restricted fund account. 

d) Make sure there is a deposit slips in the printer and click the “Print” icon at the top of 
the window. 

e) Select “Deposit slip and deposit summary” and click on OK. 

f) In the “Print Deposit Slip” window, make sure “Include Cash in Total Number of 
Deposit Items” is unchecked.  Checks with the same number should be counted as 
one item.   

g) Select “Print”. 

3. Compare the deposit slip just prepared with the log file received.  Confirm that the 
amount of each deposit item in the log file is the same as that reported by QuickBooks on 
the Deposit Summary Report.  Indicate the amount is correct by placing a red checkmark 
next to the item in the Deposit Summary section of the deposit slip printed from 
QuickBooks. 

4. Click on “Save & Close”.  Repeat from step 2 until all log files have equivalent 
QuickBooks deposit slips. 

5. Staple the log file and deposit receipt to the QuickBooks deposit summary and file them 
in the financial records folder for the month in which the deposit was made. 

 
End of Procedure 
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10.8 Generate Donation Acknowledgements 
 
Purpose 
To generate the appropriate acknowledgement for donations or the fulfillment of pledges 

 
Assumptions 

• All donation checks have been recorded in QuickBooks and have been deposited. 

• The receipts for the week may have included the fulfillment of a stewardship pledge. 
 
Main Procedure 
 
1. Select Reports>Memorized Reports>Recent Donations Report – not pledges. 

Items selected for this report are Nativity, Stewardship, and Pascha.  This report is a 
check against the number of forms printed in steps 3 and 4. 

2. Enter a date range that includes only the date on which the most recent donations were 
received and click OK and print the report. 

3. Select Reports> Memorized Reports>Recent Donations Report – not pledges. Enter the 
date range from 8/16 through today’s date.  Click OK and print the report.  This report 
will confirm the SOW category for each recent donor. 

4. Using the reports from steps 1and 3, note on the report from Step 1 the membership 
category for each recent donor, by viewing the year-to-date total of donations. 

5. Select Print/Forms/Sales Receipts.  QuickBooks will display a list of sales receipts that 
are ready to be printed. Click OK. 

6. Select Print and print to an Adobe Acrobat file saved under Donation 
Acknowledgements.. 

7. Confirm that the Acknowledgement Letters reflect the correct donor category.  If the 
category for the donor is at a higher level than that indicated for the most recent donation, 
find the recent Sales Receipt and select the correct template and save.  Reprint the letter 
after corrections have been made. 

8. Email the Adobe Acrobat file to His Grace Bishop Benjamin for signature.  

 
End of Procedure 
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Alternate Flow at Step 8:  Receipts for Week include a fulfilled pledge  
 
1. Select Reports>Memorized Reports>Status of Stewardship pledges, enter 8/16/XX – to 

current date for the date range and print the report  
2. For each pledge completed as of the date of completion, select Customer>Create 

Statement.   
3. Use the receivables account Stewardship Pledges  
4. Select the appropriate statement template “Completed ……Pledge”.   
5. Enter the appropriate date range.  Uncheck “Do not create statements with a zero 

balance”. 
6. Select the name of the donor(s) who completed their pledge.   
7. Click Preview and make sure the template form is current.  
8. Select Print.  Print to Adobe Acrobat and save file under Donation Acknowledgements.   
9. Email the Adobe Acrobat file to His Grace Bishop Benjamin for signature.  
10. Repeat from Step 2 of this alternate flow until pledge acknowledgements in all categories 

are printed. 
 
End of Alternate Procedure 
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11 DAILY/WEEKLY – ENTER/PAY BILLS AND REIMBURSEMENTS 

Controls 

• No checks may be made payable to Cash 

• The Treasurer may pay bills only for budgeted expenses without prior authorization.   

• On December 10, 1999, the current Treasurer, Mary Caetta, was authorized by the Diocesan 
Council to be the only required signer on checks in order to permit access to online banking 
which allows for direct deposit of paychecks. 

• If the Treasurer is not able, the Chancellor and any other authorized signers on an account 
may also sign physical checks to pay bills.   

• Requests for reimbursement for budgeted expenses must be accompanied by receipts.   

• Requests for payment out of the deanery youth budget must be accompanied by receipts or 
by a written request from the local Dean. 

• Expenses charged to the diocesan American Express Card must be substantiated with 
receipts.  These receipts must be submitted to the Treasurer on a monthly basis. 

• A check may be made payable to the treasurer only for the stipend payments or budgeted 
office expenses substantiated with receipts. 

 

Electronic Bill Pay through QuickBooks 
In order to avoid fraud and forgery of Diocesan physical checks, bills will be paid through 
QuickBooks Bill Pay where practical.  Checks are created in QuickBooks and sent electronically 
to the bank associated with the account.  The bank then sends the information to a third party 
bank and the check is issued from that bank, eliminating the identification of the banking account 
number with the Diocese of the West.  The password associated with QuickBooks Bill Pay is 
stored in the hard copy Appendix to this document. 
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11.1 Enter Bill from External Vendors for Budgeted Expenses 
Purpose 
To ensure that bills from external vendors for budgeted expenses are paid by the due date 
 
Assumption 
External vendors has sent an invoice for services and/or items 
 
Procedure  
1. Open QuickBooks 

2. Select Vendors>Enter Bills 

3. Enter the following information from the invoice into the Enter Bills – Accounts Payable 
screen 

• Vendor Name 

• Due Date 

• Amount Due 

• Invoice Number in Ref. No. field 
4. Select the expense account(s) for the billed expense(s) and enter the Class (of the expense 

– operating, outreach, restricted) 

5. Select Save and Close. 

6. File the paper invoice in the folder with blank checks and bills to be paid. 

End of Procedure  
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11.2 Enter Bill for Reimbursement Request (Substantiated and/or Authorized)  
Purpose 
To ensure that reimbursement requests are accompanied by substantiating receipts and/or 
authorization from The Bishop, a Department Chairman, or person authorized to manage an 
activity and associated expenses. 
 
Assumptions 

• Department Chairmen who may request or authorize reimbursements 
Department of Communications 
Department of Charities 
Department of Education 
Department of Missions 
Department of Stewardship 
 

• Receipts relevant to the request have been received either by mail or in person 

• The treasurer has verified that the total of the receipts matches the total amount of the 
reimbursement request. 

• Authorization for the payment of the reimbursement is documented either in a letter or in an 
email. 

 
Procedure 
1. Open QuickBooks 

2. Select Vendors>Enter Bills 

3. In Vendor Name field, enter last name, first name of the requester. 

4. For the Due Date, enter a date 15 days from today. 

5. In the Amount Due field, enter the total amount of the request 

6. In the Ref. No. field, enter an identifying number for the receipt or group of receipts or 
the authorization.  The identifying number should start with the initials of the requester 
followed by the date the request was received in the format DDMonYY followed by the 
initials of the person authorizing the payment of the request. 

7. Select an existing expense account(s) for the requested expense(s) and enter the Class (of 
the expense – operating, outreach, restricted).  If the request is an unbudgeted expense, 
select and/or create the account for the unbudgeted expense. 

8. Select Save and Close. 

9. Staple together the receipts and authorization for the request and enter the identifying 
number from Step 3 on the first page of the documentation. 

10. File the paperwork for the request in the folder with blank checks and bills to be paid. 

End of Procedure 
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11.3 Reconcile and Pay Credit Card Charges 
Purpose 
To ensure that expenses, charged to the Diocesan Credit Card account, have been properly 
verified and substantiated. 
 
Assumptions 

• Current authorized holders of Diocesan Credit Cards 
Bishop Benjamin 
Archpriest Matthew Tate 
Archpriest Ian MacKinnon 
Mary Caetta 
Barry Migyanko 

• Every effort shall be made by the holders of the cards to keep receipts for charges.  For other 
than travel expenses from the operating budget, the receipts shall indicate what expense 
account shall be charged. 

• Receipts must be presented for all expenses over $25.00. 

• Notification has been received that the statement has been available on the Credit Card 
website. (See paper copy of Appendix of this document for Web site information) 

 

Procedure 
1. Go to the Credit Card site and view the statement for each card holder. 

2. Print each statement to a PDF file and email the file to the cardholders, requesting that 
they verify the charges are correct and forward any outstanding receipts. 

3. Print to hardcopy and PDF the entire statement.  Save the PDF statement to the Diocesan 
Files folder in the DOW Bills and Receipts folder. 

4. Reconcile the charges recorded in the QuickBooks Credit Card account, with the charges 
indicated on the statement.  Enter in the Ref. No. field an identifying number for the 
receipt that substantiates each charge. 

5. Allow QuickBooks to generate a manual check for the amount due.  Do not print the 
check. 

6. Go to the Credit Card Web site and schedule the payment. 

7. Print to paper and PDF the confirmation of the scheduled payment.   

8. Store the PDF of confirmation with the PDF of the statement. 

9. Attach the paper copy of the payment confirmation to the paper copy of the statement 
along with all substantiating receipts. 

10. File the package and submitted receipts in the current month folder. 

11. Update the manual check generated by QuickBooks to reflect the scheduled payment 
date.  Enter “website” in the check number field. 
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End of Procedure 
11.4 Pay Bills Entered 

Purpose 
To ensure bills are paid in a timely manner and documentation associated with the payment are 
stored in a secure manner. 
 
Assumptions 

• Bills have been recorded in QuickBooks  
• Vendors have been set up as online payees 

 
Procedure 
1. Open QuickBooks 

2. Select Vendors>Pay Bills 

3. Select the bills to be paid using Bill Pay and the account from which the bills will be 
paid. 

4. Online payment should be checked.  Confirm the correct account from which the bills are 
to be paid has been selected. 

5. Select Pay and Close 

6. Enter the Online Bill Pay password.  When the bills have been sent, print the summary of 
the transactions sent. 

7. Staple the Bill Pay Summary to the supporting documentation and file in the file folder 
for the current month. 

 
End of Procedure 
 
Alternate Procedure at step 3: 
 
1. Select the bills to be paid using a paper check and account from which the bills will be 

paid. 

2. Select Pay and Close 
3. Place blank checks in the printer 
4. Select File>Print Forms>Checks 
5. Confirm that the number of the first paper check to be printed matches the number 

presented by QuickBooks. 
6. After the checks have been printed, sign each check and staple the voucher from each 

check to the supporting documentation. 
7. Create envelopes and mail the checks. 
 
End of Alternate Procedure 
 
 
 



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v5.00 
  
 

Page 53 of 93 

 

12 MONTHLY TASKS 

12.1 Pay Monthly Stipends and Payments to LGS and Martha Mary House  
 
Purpose 
To make prompt electronic payments of monthly stipends and payments 
 
Assumptions 

• The treasurer starts the process on or about the 15th of the month prior to the date of the 
checks. 

• The treasurer issues stipend checks dated the 1st of the month for that month’s services.  
Mission priests then do not have to pay their expenses “out of pocket” in the first month of 
service.  These stipends, however, are not a reimbursement for expenses.  The payments are 
considered as payments to “independent contractors” and will be documented using 1099 
Federal Tax Forms. 

• The treasurer creates the checks in QuickBooks but sends them via QuickBooks Bill Pay for 
mailing.  The treasurer should generate the checks soon enough for them to be mailed out 
and received by the first of the next month. 

• QuickBooks checking accounts set up for QuickBooks Bill Pay 

• All payments are in the list of memorized transactions in QuickBooks. 

• If the first of the month is a bank holiday, the online payment date must be set in QB as the 
last day of the current month.  

 
Main Procedure: Select and send the Scheduled Memorized Transactions  
 
1. Open QuickBooks and double-click on Mid-Month Payments in the List of Memorized 

Transactions. 

2. Confirm that the date displayed is approximately the middle of the current month.   

3. Click OK and click OK again. 

4. Double-Click Stipends – Deanery 

5. Confirm that the date displayed is the first day of next month.  If the first day of next 
month is a bank holiday, then set the date to the first working day of that month. 

6. Click OK and click OK again. 

7. Double-Click Stipends – Mission 

8. Confirm that the date displayed is the first day of next month.  If the first day of next 
month is a bank holiday, then set the date to the first working day of that month.   

9. Click OK and click OK again  
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10. Double-Click Other Stipends 

11. Confirm that the date displayed is the first day of next month.  If the first day of next 
month is a bank holiday, then set the date to the first working day of that month. 

12. Click OK and click OK again  

13. Select Banking>Online Banking Center 

14. Click on Go Online. 

15. Refer to attachment to this manual.  Enter the PIN number and click OK. 

16. When the transactions have been sent, select “Print” in the Online Transmission 
Summary Window. 

17. Close the Online Transmission Summary Window and the Online Banking Center 
window.   

a) Staple all the pages of the online report together and file the report in the transaction 
folder for the payment month. 

End of Procedure 
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12.2 Create Monthly Paychecks 
 

Purpose: 
To create paychecks for salaried employees and clergy  

 
Assumptions 

• Direct Deposit has been set up for each salaried employee and clergy, if possible. 

• W2 forms have been filed for the prior year or will be prepared for the current year. 

• Employees are paid on the first business day of the month. 

• Paycheck items have been completed for each employee. 

• Annual wage amounts have been entered in employee profile. 

• Annual housing allowance declaration has been approved in December of the prior year 

• Any Authorized Federal Withholding amount has been documented on a W4 form for the 
current year.   

• Any additional amounts to be withheld from pay (i.e. Pension amount) have been entered in 
employee profile. 

• Clergy wages are not subject to Social Security or Medicare withholding.   

• The Diocese does not contribute to the clergy Self Employment taxes.   

• Today’s date is within the last five days of the month covered by this paycheck. 

• Paychecks will be sent by regular mail or direct deposited. 

• The account used for Direct Deposit withdrawals is Checking at Chase 

• If the payroll check date will fall on a weekend, the check date shall be the first business day 
of the next month.   

 
Procedure:   
 
1. Open QuickBooks. 

2. Select Employees>Pay Employees>scheduled payroll 

3. Highlight Monthly DD Payroll 

4. Click on Start Scheduled Payroll 

5. Set the “Check Date” field to the first day of the next month for pay period ending the 
last day of the current month. 

6. Check the names of those employees to be paid, confirm bank account for payment,  and 
click Continue 

7. Confirm there is a check in the Direct Deposit Column for direct deposit employees and 
click on Continue. 
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8. Click on the “Create Paychecks” button. 

9. For employees being paid by check,  

a.  Select Print Paychecks.   

b.  Select employees who are mailed paychecks.  Confirm that the first check number is 
correct. 

c.  Click OK and Print.  Then click OK. 

10. For employees being paid by direct deposit, click Send Payroll to Intuit. 

11. Click Send. 

12. Refer to the attachment to this manual.  Enter the direct deposit PIN and click OK.  The 
checks will be sent. 

13. Click OK on the message “Your payroll session succeeded”. 

14. Select the payroll confirmation report for today’s date. 

15. Remove any blank checks from the printer feeder. 

16. Select View and then select Print. 

17. Select the printer and click on print. 
18. Select Close and Close. 

19. File the confirmation report in the folder for next month. 

20. Display the checking account from which the direct deposit was taken. 

21. Find the most recent paychecks in the register with a zero amount and open the check.  

22. Print those checks to an Advice of Deposit check form after correcting the check number 
displayed by QuickBooks to coincide with the number on the advice of deposit form.   

23. File the vouchers in the folder for next month.  Mail Advice of Deposit checks.  

End of Procedure 
 
 
Payroll item notes for OCA Pension contributions 
 

Item Employee Contributions = 403(b)  
Not included in box 1 of the W2 form 
Not taxable for Federal Income Tax or Social Security purposes 
Amount in Box 12 is preceded with the letter E. 
 
Item Employer Contribution =501(c)(18)(D) 
Amount in box 12 is preceded with an H 
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12.3 Pay Payroll Liabilities 
 
Purpose:  
To pay withheld federal income tax, Social Security, Medicare, State income tax, and pension 
contributions.  Note Policies 8.5.1.1 and 8.5.1.2. 
 
Assumptions  

• Paychecks for the current month have been created and mailed.   

• Today’s date is prior to the 15th of the month.   

• An OCA Pension Form has been received for the current month.   

• Electronic payment of Federal 941 taxes has been set up at the EFTPS Online Web Site 

• Account and password information appears in an attachment to these procedures 

• QuickBooks 2008 is the software version being used and liabilities have been scheduled. 

 

Procedure: Generate Payroll Liability Checks  
 
In QuickBooks select Employees>Payroll Taxes and Liabilities>Pay scheduled Liabilities. 

Click the OK on the error message. 

12.3.1 Pay Federal 941 Taxes 
1. Under Pay Scheduled Liabilities, select Federal 941/944 for the period of the current 

month. 
2. Click on View/Pay and confirm that the class on the check is “Administration”. 
3. Note the amount on the check for Federal Withholding, Social Security, and Medicare. 

(latter two will only have an entry if there are non-clergy employees) 
4. Access the EFTPS online web site at www.eftps.com/eftps/ 
5. Click on Make a payment. 
6. See the hardcopy attachment to this manual for the EFTPS passwords and other 

confidential information. 
7. Login to the web site. 
8. Enter the EIN, PIN, and internet password for the EFTPS site. 
9. Select Login. 
10. Select tax form 941 Employers Federal Tax.  Select Next. 
11. Select Federal Tax Deposit, then select Next. 
12. Provide the information on the next several forms, and then click “Make Payment”. 
13. Remove any checks from the manual tray. 
14. Click on View and Save as a PDF to print the online payment confirmation.  Print to the 

printer and save the PDF file to Diocesan Files\payroll taxes\yyyy payroll\Federal as 
mm_dd_yyyy_tax deposit. 

15.  Logout of the web page. 

http://www.eftps.com/eftps/�
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16. Record the confirmation number on the memo line of the QB check after the EIN as 
Conf#:  NNNNNNN NNNNNNNN and then enter the rightmost 8 digits as the check 
number after un-checking “to be printed”. 

17. File confirmation form in this month's file folder of checks and receipts.  
18.  Save and Close the check form.  Then close the Payment Summary Window. 

12.3.2 Pay OCA Pension Liabilities 
1. Select all scheduled pension liability items for the period of the prior month. (eg. 

Withholding from July paychecks will be paid to Syosset by August 20.) 
2. Select View/Pay 
3. For each QuickBooks Employee 

a.  Fill out the amounts on the colored pension form for the employee 
b.  Confirm that the Class on the check is "Administration". 
c.  If this is not the last check, click Save and Next and repeat from step a. 

4. Click on Close and Save. 
5. Select File>Print Forms>Checks and print the check(s) 
6. Scan the colored form and print to the printer.  Attach the printed copy of the form to the 

check stub.   
7. Mail the colored form with the check. 

12.3.2.1 Non-Employee Payment of OCA Pension 
1. Enter the memorized transaction for the payment. 
2. Go to 12.3.2 Step 6. 

 

12.3.3 Pay State Withholding Liabilities (CA, if applicable) 
1. For each State 

a) Select state liability items for the period of the current month. 
b) Select View/Pay. 
c) Confirm that the Payroll item is labeled Administration. 
d) On the internet, go to the EDD website https://www.eddservices.edd.ca.gov. 
e) Click on e-Pay, Electronic payments, Payroll Tax Deposit, DE88. 
f) Click on Just Pay it. 
g) Enter the EDD Employer Account #: 816-6101-9 
h) Enter the personal income tax amount 
i) Click Continue and enter the required information. 
j) Print the page to a PDF file and the printer. 
k) File the printed copy in the folder for the month. 
l) Use the reference number for the check number in QuickBooks. 

 
 

End of Procedure 
 

https://www.eddservices.edd.ca.gov/�
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12.4 Generate Monthly Assessment Invoices and Assessment Statements 
 

Purpose 
To assure that receivables are kept to a minimum 

 
Assumptions 

• In the memorized transactions list, the memorized Fair Share Assessment invoices for the 
current year have already been created per the procedure Create Memorized Monthly Fair 
Share Invoice. 

• In the memorized transaction list, the initial memorized DPA Assessment invoices for the 
current year have been created and adjusted for any financial reports received to date. 

• “To be printed” has been selected on each memorized invoice. 

• It is after the 15th of the month but before the 20th of the month. 
 
Procedure:   
1. Click on the group of memorized Fair Share Assessments and enter the date of the first 

day of next month.  Click OK. 

2. Click on the group of memorized DPA Assessments and enter the date of the first day of 
next month.  Click OK. 

3. Select Print Forms>Invoices, and print all the Fair Share Assessment invoices. 

4. Select Print Forms>Invoices, and print all the DPA Assessment invoices. 

5. Place the invoices in two piles. 

6. Select Customers>Create Statements 

7. Set the statement date for the first day of next month. 

8. Set statement period from the beginning of the current year to the first day of next month.  

9. Click on the radio dial for Customers of Type. 

10. Select DOW Parish>DPA.  Select the template DPA Statement –v1.00.   

11. Select A/R Account field to Assessment Receivables. 

12. Enter “Per Job” in the Create one statement field. Click on “Print due date on 
transactions”. 

13. Select Do not create statements “with a zero balance” and “for inactive customers”. 

14. Select Preview in order to confirm specified settings were selected. 

15. Print the statements. 

16. Repeat Steps 6 through 9 

17. Select DOW Parish>Fair Share.  Select the template Fair Share Statement – v1.00. 

18. Select A/R Account field to Assessment Receivables. 
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19. Enter “Per Job” in the Create one statement field. Click on “Print due date on 
transactions”. 

20. Select Do not create statements “with a zero balance” and “for inactive customers”. 

21. Select Preview in order to confirm specified settings were selected. 

22. Print the statements. 

23. Create stamped envelopes for all parishes, stuff the envelopes and mail 

End Procedure 
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12.5 Make Fair Share Assessment Payments 

 
Purpose 
To forward, on the 15th of the month, the Fair Share Assessments collected from the parishes to 
the Orthodox Church in America (OCA) 

 
Assumptions 

• The OCA has determined the annual Fair Share Assessment owed by the Diocese for the 
diocesan parishes.  

• The Fair Share Assessment is based on the September 1 census of the previous year  

• The Diocesan Council has determined the parish per member Fair Share rate to be invoiced.  
 
Main Procedure 
1. Run the year-to-date operating income/expense report. 

b) Note the total amount collected from the parishes as of the 15th of the current month. 

c) Create a check for the amount collected and made payable to the Orthodox Church in 
America. 

d) Print and sign the check.  File the stub in the current month’s payment folder. 

e) Mail the check to: 

f) The Orthodox Church in America 

g) PO Box 675 

h) Syosset, NY 11791-0675 

End of Procedure 
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12.6 Reconcile Asset Account Statements 
 
Purpose 
Reconcile the statements from financial institutions with the account information in QuickBooks 
 
Policy  
 

Paper or electronic statements from banks and financial institutions shall be sent by the 
Treasurer to a member of the Finance Committee.  That person shall review the checks that 
have cleared the account, deposits that have been made, and investigate any unusual 
transactions.  The Treasurer shall perform the reconciliation of the statement with the 
associated QuickBooks Asset Account.    

 
Organization of the Monthly Folder Content 
 
Clipped on the left side of the folder are: 
 Statements and Reconciliations for asset accounts 
 Deposits to the asset accounts 
 Electronic transfers between the asset accounts 
 Other relevant communications regarding the asset accounts. 
 
Clipped on the right side of the folder are: 
 Check vouchers and associated receipts in voucher number order from low to high 
 Copies of electronic payments in order by date of payment. 
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12.7 Prepare Monthly Financial Report 
 
Purpose 
Generate and distribute a monthly financial report package to the members of the Diocesan 
Council, Diocesan Departments, Deans, Finance Committee, and Audit Committee. 

 
Assumptions 

• The Treasurer’s Web page has been formatted to accept links to monthly financial reports. 

• All reports will be accrual based reports. 

• The report package will consist of the following: 

° A verbal summary of the month's financial activities  
° A balance sheet showing roll-up and detail of financial position as of the end of the 

month.  
° A report showing roll-up and detail unrestricted operating income and expenses for 

the year to the end of the month and compared to what was budgeted for the entire 
year. 

° A report showing restricted fund activity 
° A report of parishes having assessments 30 or more days past due. 

 
Main Procedure: Generate and Distribute the Monthly Report 
 
1. Open QuickBooks 

2. Run the QuickBooks report Company & Financial/Profit & Loss/Profit & Loss 
Unclassified. 

3. Classify any transactions that appear. 

4. Run the memorized reports MR Monthly Treasurer Reports/ 

° “MR – Profit and Loss Budget vs. Actual” for the current year 

° “MR – Consolidated Balance Sheet” for end of previous month 

° "MR - Sale of Point Reyes Fund Year to Date Profit & Loss" 

° "MR - Restricted Mission Fund Year to Date Profit & Loss" 

° "MR - Point Reyes Funds Balance Sheet" 

° "MR - Open Invoices" - (to end of previous month) 
 

5. Review each of the first five reports in expanded form and correct any bookkeeping 
errors found.   

6. Print the expanded form of each of the first four reports to a PDF and save the files in the 
directory Diocesan Documents\Treasurer Reports\20XX.  

7. Print all six reports to the printer. 
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8. Export the expanded QuickBooks P&L report to an Excel spreadsheet and format the 
spreadsheet for a one page report. Collapse to the major categories.  Adjust to 95% and 
adjust all margins to fit report on one page, then print to a PDF in the directory Diocesan 
Documents\Treasurer Reports\20XX as mm_month_yyyy_P&L Summary. 

9. Export the collapsed QuickBooks Balance Sheet Report to an Excel spreadsheet and 
format to a one page report.  Adjust to 100% and center on the page horizontally, then 
print to a PDF in the directory Diocesan Documents\Treasurer Reports\20XX as 
mm_month_yyyy_Balance Sheet Summary. 

10. Open the Word version of Diocesan Documents\Treasurer Reports\20XX 
Reports\<Previous Month> Cover.  Refer to the printed reports for the necessary detail 
needed to create this summary report. 

11. Save the summary report as <Current Month> Cover.  Print the summary report cover to 
the printer and then to a PDF file named <mm_month_yyyy> Financial Report Summary.  
Append the PDF of the rolled-up P&L and Balance Sheets and save this report in the 
20XX directory.  

12. Create one PDF report from the detailed P&L,  Balance Sheet, and restricted funds 
reports  and save the resulting report as <mm_month_yyyy Financial Report-Detailed. 

13. Close QuickBooks 

14. Email  the <mm_month_yyyy> Financial Report Summary and the <mm_month_yyyy 
Financial Report-Detailed as attachments to the distribution list indicated in the purpose 
of this procedure and to the Administrative Assistant.  The distribution list is maintained 
in the Outlook group Monthly Treasurer Report. 

15. Email the checking account bank statements to the appropriate member of the Finance 
Committee. 

 
End of Procedure 
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13 QUARTERLY TASKS 

13.1 Create a Quarterly IRS Form 941 
 
Purpose 
Create and file Form 941 to reconcile monthly withholding tax deposits. 

 
Assumptions 

• The IRS had the correct legal address and information when Web was used to enter the 
monthly deposit information.  

• Cannot file form 941 on line as of yet  - 22 April 2008 
 

Procedure 
 
1. Open QuickBooks 

2. Select Reports/Employees & Payroll/Payroll Summary (unclick rate and hours box). 

3. Select this or last calendar quarter for the date range. 

4. Click OK. 

5. Print the report to a PDF and save to Payroll Taxes\yyyy Payroll\QtrN Payroll Summary. 

6. Select Employees>Payroll Tax Forms & W-2s>Process Payroll Forms. 

7. Confirm that the Select Form Type Screen has Federal Form selected and click OK 

8. Select “Quarterly Form 941/Schedule B”, select the appropriate quarter, then click OK 

9. Proceed through the steps displayed by QuickBooks.  It is not necessary to complete a 
Schedule B. Enter CA for the state where deposits are made. 

10. Compare the deposit amounts for the quarter with the QuickBooks deposit amounts.   

11. Line 2 of Form 941 should be the same as the Adjusted Gross Pay. 

12. Print the Form 941 and sign the form.  Scan the signed form to a PDF and  save the 
Acrobat file to Diocesan Files\Payroll Taxes\yyyy Payroll\Federal\941qtrN. 

13. Close QuickBooks and mail the form. 

 
End Procedure 
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13.2 Prepare Quarterly, California (EDD), Wage and Withholding Report, Form DE6. 
 
Purpose 
For employees who work in the State of California, to report to the State, the amount of 
withholding from employees' checks during the previous quarter  

 
Assumptions 

• EDD Employer Account number is 802-1151-9 

• California Income Tax withheld from employees' check during the quarter has been mailed in 
using form DE88. 

• DE6 form received in the mail from the State of California. 
 

Procedure 
1. From QuickBooks, generate a quarterly wage report by selecting Reports\Employees & 

Payroll\Payroll Summary (unclick rate and hours box). 

2. Select this or last calendar quarter for the date range. 

3. Click OK. 

4. Print the report to paper and the Acrobat Distiller.  Save the PDF under the Payroll Taxes 
directory.  Save with a filename “QtrN Payroll Summary”.  Close the report screen. 

5. Close QuickBooks. 

6. Go to the following web site to report on state income tax withheld. 

                                     https://eddservices.edd.ca.gov/index.html 

 

7. Click on iFile. 

8. See the hardcopy attachment to this manual for web site password information. 

9. Enter the User ID and Password specified. 

10. Select “Create New DE6”. 

11. Select the tax period and click Next. 

12. Enter the number of employees subject to CA income tax for each period and click Next. 

13. Select the “prefill” radio button, and then click Next. 

  

https://eddservices.edd.ca.gov/index.html�
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14. For each employee, enter  

   Subject UI wages: 0.00  
   PIT wages (gross pay less pension) 
   PIT withheld 

 

15. Click Next. 

16. Select Submit. 

17. Review information and select “submit DE6”. 

18. Select “printer friendly version”. 

19. In the “printer friendly” format window, select File\Print. 

20. Select Adobe PDF printer and click Print. 

21. Save the file in c:\Diocesan Files\Payroll Taxes\yyyy Payroll\State\ as DE6qtrNYY. 

22. Print adobe file to HP Printer. 

23. Close the Adobe window and the “printer friendly” window. 

24. Log out at the main window and close the browser. 
25. Make sure the quarterly payroll report and related information is saved in the Payroll 

taxes file, either a paper or electronic folder. 

End of Procedure 
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13.3 Adding/Removing a Stipend Payee 
 
Purpose 
To record and report necessary information when there is a new addition to the list of those 
receiving stipends.   

 
Assumption 

• Those receiving stipends are paid as independent contractors and will receive a 1099 form.   

• The check dated the first of the month covers work performed during that month. 

• The Dean of the Missions Deanery has submitted to the Diocesan Council a revised list of 
mission priests who should receive stipends. 

 
Procedure (Add a Mission Stipend Payee as a Vendor) 
1. Open QuickBooks and display the list of vendors. 

2. Click on Vendor>New 

3. Enter the information about the mission priest on the Address Info tab. 

4. Click on the Additional Info tab 

5. Enter Last name into Account Number field 

6. Enter Non Employee into the Type field 

7. Enter the priest’s Social Security Number in the Tax ID field. 

8. Check the box Vendor eligible for 1099 

9. Click OK 

End Procedure 
 
Alternate Flow at Step 1 (Vendor already in QuickBooks) 
1. Double-Click on the name of the mission priest. 
2. Click on the Additional Info tab 
3. Continue with Step 7 
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Procedure (Update Existing Memorized Stipend Transaction) 
1. Select Lists>Memorized Transactions List 

2. Scroll down to Stipends – Missions  

3. Double-Click on name of mission priest in the list. 

4. In the check window that opens, update the amount of the stipend to be paid in 
succeeding months. 

5. Select Edit>Memorize Check 

6. Click on Replace 

7. Close window and Click on No. 

End Procedure 
 
Procedure (Create a Memorized Stipend Transaction) 
1. Click on the Write Checks Icon at the top of the QuickBooks Menu 

2. Create a check for the mission priest entering the amount of the monthly stipend 

3. Select Edit>Memorize Check 
4. Enter the Mission Priest Name in the Name field 

5. Click on With Transaction in Group 

6. Enter Stipends – Missions in the Group Name field 

7. Click OK 

End Procedure 
  



Diocese of the West, Orthodox Church in America  Financial Accounting Policy and Procedures Manual v5.00 
  
 

Page 70 of 93 

14 ANNUALLY 

14.1 Fair Share Assessment 
The diocese invoices each of its parishes based on the per-member rate. The Diocesan Treasurer 
pays The Orthodox Church in America (OCA) 1/12 of the annual amount due by the 15th of each 
month.  In some months, the diocese may have to pay more in Fair Share Assessments to the 
OCA than it receives from the parishes. 

14.1.1 Collect and Report Parish Membership Numbers (September 1 – October 10) 
 
Purpose 
To collect and report the number of members in a parish as of September 1 of the current year 
 
Assumptions 

• The rector of each parish will determine the number of members to report. 

• The number of members reported will be contained in the parish report submitted for the 
Diocesan Assembly Delegate Report Book. 

• The Diocesan Assembly takes place in early October of the current year. 

• The deadline for submitting parish reports for the Delegate Report Book is September 30 or 
sooner. 

 
Procedure: 
1. On or before August 5 of each year, send out the letter requesting reports for the Delegate 

Report Book (see section XX for details. 

2. Create a new Fair Share file, C: \Diocesan Files\Fair Share & Census\FS Reported to 
OCA YYYY to capture the membership numbers as they are reported. 

3. Create a new excel file, Diocesan Files\ Parish Financials & Membership\ParassYYYY 
from the template provided.  Update the template, if necessary. 

4. As the parish reports are received, record the number of reported members in both files. 

5. Create a PDF version of the file, FS Reported to OCAYYYY. 
6. Email the final Fair Share membership numbers to the treasurer of the OCA by October 

15. 

End Procedure 
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14.1.2 Update Memorized Monthly Fair Share invoice 
 
Purpose 
To create a QuickBooks memorized invoice transaction which can be entered monthly 
 
Assumptions 

• The memorized transaction group Assessment - Fair Share exists 

• Each diocesan parish is listed as a QuickBooks Customer (See how to set up a parish as a 
customer) 

• A memorized Fair Share Assessment invoice for the parish already exists in the group 

• The class selected for the invoice is FS 

• Invoice Template selected is Fair Share Invoice -  v1.00 

• To be printed is checked 
 
Procedure: 
1. Update the Fair Share item in the Item List to reflect the current per-member rate. 

2. Make any necessary modifications to the QuickBooks template form “Fair Share Invoice 
- v1.00”. 

3. Open a memorized invoice 

4. To the description for the item, Fair Share, add the number of members reported and the 
per-member rate.  (ex. “(57 members * 106.00/12 months)”) 

5. In the rate column, enter the number of members divided by 12. 

6. Tab to the next column.  The monthly fair share amount for the parish will appear in the 
last column. 

7. Click Edit/Memorize Invoice in the QuickBooks main menu.  Clicks REPLACE to 
replace the existing invoice. 

8. Close the invoice window and click No when asked if you want to record the transaction. 

9. Go to the next memorized invoice and repeat from Step 3 until all invoices have been 
updated. 

10. Print Invoices and Create a Fair Share Assessment Statements after following the 
procedure for creating memorized DPA Assessment invoices. 

 
End Procedure 
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14.2 Determine the DPA Assessment 
The Diocesan Percentage Assessment (DPA) is an assessment paid by the diocesan parishes for 
the support of the diocesan operating budget.  The amount of the DPA to be paid in a given year 
is determined according to the policy in Section XX of this manual from the parish financial 
report for the previous year.  Parishes with fewer than 10 members are not liable for payment of 
a DPA. 

14.2.1 Request of Parish to send Annual Financial Report and updated Mailing List. 
(December)  

 
Purpose 
To notify Diocesan Parishes that enclosed Estimated DPA Assessment for January of next year equals 
current year monthly DPA and to request  parish Financial Report (P&L at a minimum) for the current 
year be sent to the treasurer.  

 
Assumptions 

• Today’s date is about December 15. 

• The Diocesan Percentage Assessment (DPA) amount for the first quarter of next year or until 
a new rate can be computed from the parish financial report, will be billed at the same rate as 
this year.  

• All memorized parish DPA invoices are in the memorized transaction group called 
Assessments – DPA. 

• All parishes appear as QuickBooks Customers. 

• All existing memorized invoices use the liability account, Diocesan Percentage Assessments 

 
Procedure:  
1. Confirm the statement template “DPA Statement – v1.00” is available. 

2. Open the first memorized DPA invoice. 

3. Change the invoice template from DPA Assessment Invoice to Estimated DPA Invoice. 

4. Change the customer message to “Please send your Parish Financial Report for last year 
to the Office of the Treasurer.” 

5. Make sure the “To be printed” box is checked. 

6. Memorize the invoice, clicking on Replace to replace the previous memorized invoice. 

7. Close the parish invoice window and click NO in response to the message “Do you want 
to record the transaction?” 

8. Repeat for each memorized invoice from step 2 until the last invoice is updated. 

9. Go to the procedure for printing all DPA and Fair Share Invoices and creating statements.   

10. Modify the annual letter to parishes, which is located in c:\Diocesan Files\Templates\ 
Request for Annual Report Info_YYYY.doc. 
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11. Print sufficient copies of this letter requesting annual reports and mailing lists. 

12. Separately from the Assessment Invoices and Statements, mail the Request for Annual 
Report to all parish treasurers AND rectors. 

End Procedure 
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14.2.2 Computing the Diocesan Percentage Annual Assessment (DPA) (As parish financial 
reports are received) 

 
Purpose 
To review each parish’s annual report and enter the necessary information into a spreadsheet 
 
To compute the parish annual and monthly DPA assessment and to determine the total DPA Assessments 
that should be received for the year. 

 
Assumptions 

• The approved policy on the computation of the DPA is followed. 

• An excel file, Diocesan Files\ Parish Financials & Membership\DPA_ FS by parish by 
year\ParassYYYY, has been created for the current year. 

• Each parish has a calculation worksheet in the file ParassYYYY 
 

Procedure 
1. If the report is received via email, save the report under Diocesan Files\ Parish Financials 

& Membership\Parish name\YYYY.  Print the report 

2. Open the file ParassYYYY and select the calculation worksheet for this parish. 

3. Using the parish profit and loss report, fill in the worksheet. 

4. Print the worksheet for the parish 

5. Enter the rector salary figures on the worksheet titled “statistics” 

6. If the report was received only as a hard copy, scan the report and save it under Diocesan 
Files\ Parish Financials & Membership\Parish name\YYYY 

7. Change the memorized DPA invoice for this parish from an “estimated invoice” to an 
“adjustment invoice” as described in the procedure for creating a memorized adjustment 
invoice. 

8. With the next month’s mailing of invoices, mail the printed calculation sheet along with 
the adjusted invoice, Fair Share invoice, and any necessary statements. 

End Procedure 
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14.2.3 Create Adjustment and Assessment Invoices for the Month. 
 
Purpose:  
To create a memorized invoice that reflects the DPA assessments owed year-to-date based on the 
previous year’s annual report, less the amount already invoiced in the current year. 
 
Replace memorized Adjustment Invoices with memorized regular assessment invoices. 

 
Assumptions:   

• Annual Reports have been received from some parishes 

• No DPA invoices for next month have yet been generated 

 
Procedure:  
1. Open QuickBooks and go to the memorized transaction list, group “Assessments - DPA”. 

2. Open the memorized DPA invoice for a parish. 

3. Take the parish DPA calculation sheet created in procedure for computing the DPA.  

4. Insert a line before the DPA line.  Select DPA as the Item. 

5. Add “(Jan-<next month>)” after the description, enter number of months under quantity, 
and then enter the monthly rate from the printout. 

6. In the old DPA line add “previously invoiced (Jan-<this month>)” and multiply number 
in the months column by (minus <number of months using old rate>) 

7. Check “to be printed” 

8. Select the invoice template “Adjustment DPA Invoice – v1.00” 

9. Set date to <first date of next month> 

10. Set the customer message to “Please remit with copy of invoice by 15th of the month.” 

11. Memorize the invoice, replacing the old invoice. 

12. Click Save and Close 

13. Repeat from step 2 for the next parish. 

14. Go to the procedure for printing DPA and Fair Share Assessments and Statements, 
including the calculation sheet will all adjustment invoices. 

End of Procedure 
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Alternate Flow at Step 2:  Invoice opened is already an Adjustment Invoice. 
 
1. Delete the 2nd DPA line (i.e. old rate). 
2. Change the number of months on the remaining DPA line to 1.  Remove the note (Jan-

<next month>) 
3. Change the template to “DPA Assessment Invoice v1.00”. 
4. Memorize the invoice, select replace, click on X to close the invoice window.  
5. Select No. 
6. Continue at step 2 in the main procedure 
 
End of Alternate Flow 
 

 
Alternate Flow at Step 2:  Invoice opened is a regular assessment invoice 
 
1. Close the windows and click No. 
2. Continue at step 2 in the main procedure. 
 
End of Alternate Flow 
 
Alternate Flow at Step 3: Invoice opened is estimated assessment and no parish Annual 
Report Yet Received  
 
1. Close the windows and click No. 
2. Continue at step 2 in the main procedure. 

 
End of Alternate Flow 
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14.3 Prepare Assembly Assessment Invoices (July)  
 
Purpose 
To prepare the parish Assembly Assessment Invoices and to prepare to receive Observer fees. 

 
Assumptions 

• The Administrative Assistant has posted notification of the assembly and the registration 
forms. 

• The hosting deanery and the Diocesan Administrative Assistant have determined estimated 
assembly costs by July 1. 

• Observer charges will cover cost of postage, supplies, and food and have been noted on the 
Observer Registration form.   

Procedure 
 
1. Edit the list of memorized assembly invoices from the previous year. 

2. For each parish or mission, apply a per capita rate or parish-size rate. 

3. Memorize each invoice. 

4. Enter the set of invoices, setting an August 1 date as the date of the invoice. 

5. Print and mail the invoices along with the assembly registration packet. 

6. Create an assembly receipt item to be used for observer sales receipts. 

 
End Procedure 
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14.4 Prepare Draft Budget for following year (July through October) 
 
Purpose 
To describe the process of deriving a draft of the following year’s budget for presentation and 
discussion at the Diocesan Assembly 

 
Assumptions 
• An Excel Spreadsheet has been formatted to have a year-to-date column, a current year 

budget column, a proposed budget column, and a column for notes. 
• The Budget Memorandum, attached to this procedure, has been reviewed for use in the 

current year. 
• The Diocesan Council has appointed a Finance/Budget Committee. 
 
Procedure 
1. The head of the Finance/Budget Committee schedules a meeting date. 

2. The Treasurer distributes the Budget Memorandum by July 1 of the current year. 

3. Review year-to-date actual figures and submitted requests to determine initial estimate of 
figures in the proposed budget column of the Excel worksheet.  

4. Meet with the Finance/Budget Committee. 

5. Email the draft budget to committee members for initial feedback and reaction. 

6. After input from the committee, create the draft budget that will be included in the 
assembly materials and presented to the Diocesan Council for pre-assembly approval. 

7. Compile: the proposed budget; the August Treasurer’s Report; the previous year’s 
audited report; the audit findings into a Word document for the report package. (Include 
an updated membership historical report for the last 10 years and parish assessment 
report.)  

8. Copy the report package to a CD or email the report to the person responsible for 
assembling the assembly report book.  

9. Copy the “preliminary” budget file to the treasurer’s laptop in order to facilitate any 
necessary editing required at the meeting of the council the evening prior to the Diocesan 
Assembly. 

10. After presentation of the budget to the Diocesan Council,  include any necessary 
modifications and obtain DC approval for presenting the budget to the assembly. 

11. A Finance/Budget Committee member presents the budget to the assembly for 
modification and/or approval. 

End Procedure 
 
 
Procedure Attachment on following page: 
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MEMORANDUM 
 

Date: July 1, 20XX 
 
To: The Diocesan Council, Diocesan Charitable and Monastic Institutions, and Department Chairs 
Re: Submitting Budget Requests 
 
This memorandum describes the process used to create the Proposed Budget submitted to the Diocesan Assembly 
for its approval.   It is distributed to inform and facilitate budget requests. 
 

1. The Diocesan Council has appointed a Finance/Budget Committee.  Current members are:  (insert names 
of members of Budget Committee)  

 
2. The Diocesan Treasurer shall elicit budget requests for 2004 by distributing this memorandum by July 1, 

20XX. 
 

3. All budget requests must contain the name of the requesting party, the proposed project, the amount 
requested and other sources of funds, if any.  Proposed purchases should be supported by vendor quotes or 
other price research.  The request should indicate how much will be spent on what and approximately when 
the expenditure will occur. 

 
4. Budget requests from Diocesan Institutions shall be sent prior to August 1, 20XX  to:  

 
Charities Department, Diocese of the West 

(Insert address of Chairperson) 
 

5. The Diocesan Charities Department shall review the projects proposed by the institutions and the amount 
of financial assistance requested, consider and prioritize those requests and submit that prioritized list of 
their recommendations and original requests to the Finance/Budget Committee by August 15, 200X. 

 
6. All other budget requests shall be sent to the Office of the Finance/Budget Committee by August 15. 

 
7. The Diocesan Treasurer shall provide and propose initial funding levels for next year’s budget. 

Finance/Budget Committee shall review year-to-date actual figures for already-funded projects, the 
budget recommendations received and the funding request for new projects.   

 
8. The Finance/Budget Committee shall convene in the third quarter of the year prior to the meeting of the 

Diocesan Council.  The Budget Committee shall review the proposed budget, make those changes it 
supports and finalize the Proposed Budget for presentation to the Diocesan Council. 

 
9. The Diocesan Treasurer shall publish the draft of the Proposed Budget prior to the Diocesan Council’s 

3rd quarter meeting.  If time pressure requires, this draft may be included in the Delegate Report Book with 
the advisory that the Diocesan Council must still review and approve the Proposed Budget that will be 
considered by the Diocesan Assembly. 

 
10. The Diocesan Council shall then make final changes to the draft budget.  The Diocesan Treasurer shall 

incorporate these changes into the Proposed Budget and prepare it for presentation to the Diocesan 
Assembly by a member of the Finance/Budget Committee. 

 
11. The Diocesan Assembly shall discuss the Proposed Budget, make any changes (by majority vote) and 

formally adopt the budget for the following year.  
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14.5 Create Stewards of the West List for the Delegate Report Book 
 
Procedure 
 
1. Use the Sales by Customer Summary Report 

2. Set Date Range as August 16, XXXX(prior year) to August 15, XXXX (current year) 

3. Select all Stewards of the West income accounts. 

4. Generate the Report. 

5. Export the data to an Excel spreadsheet 

6. Delete the header of the report 

7. Delete any unnecessary columns 

8. Ungroup the row data 

9. Sort by Amount, descending and Name, ascending 

10. Create a new Total Contributions line 
11. Remove the screen split 

12. Manually divide the names into the SOW ranges 

• GE $1,000 
• GT $500, LE 999.99 
• GT $100, LE 499.99 
• Remaining range 

 
13. Insert the names of any Lifetime Beacon donors. 

14. Enter SOW category above each section in names column 

15. Make the membership categories BOLD. 

16. Tidy up the parish names and make sure all names are sorted with the group 

17. Add the Total amount into the Name column 

18. Delete all dollar amounts 

19. Save file as 200X (Current year) Stewards of the West 

20. Insert into the Assembly Report Book Content folder. 
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14.6 Create Treasurer’s report for Delegate Report Book (September 1) 
 

Purpose 
To create the necessary reports that will be included in the binder of reports for assembly 
delegates. 
 
Assumptions 

• The previous year’s audited financial report and auditors report shall be posted on the 
Diocesan Web site. 

• The reports to be included in the electronic Delegate Report Book are 
- Current month (August) operating income and expense year-to-date budget vs actual 

report 

- Current month (August) consolidated balance sheet  

- Previous 5-year census report  

• Proposed budget for next year 

Procedure 
1. Open QuickBooks 

2. Create the three reports specified above from the set of Monthly Treasurer Reports 

3. Print reports to PDF files which can be inserted into the report book. 

4. Open the file Diocesan Files\Fair Share and Census\Census_to_01_Sept_0X. 

5. Use the latest figures from this file to update the Delegate Report Book Fair Share 
Census Report. 

6. Print the proposed budget file to a PDF file and insert into the report book file. 

End Procedure 
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14.7 Prepare Annual Tax and Reconciliation Forms 

14.7.1 Prepare Annual California (EDD) Reconciliation Statement (January) 
 
Purpose 
To confirm that the California subject wages reported and income tax withheld from employees 
and paid to the state each quarter is equal to the subject wages and withheld taxes for the year. 

 
Assumption 

• Form DE7 received from the State of California. 

• Quarterly California DE6 forms filed either electronically or in paper form. 
 

Procedure 
1. From QuickBooks, generate a payroll summary sheet for the reporting year by selecting 

Reports\employees & payroll\payroll summary.  Select the calendar year and unclick rate 
and hours box.  

2. Print the report to the Payroll Taxes\YYYY folder using Acrobat Distiller. 

3. Fill out the Form DE7. 

a. Line C, Total Subject Wages, should equal the sum of PIT wages reported on the 
quarterly DE6 reports. 

b. Lines D through F are pre-filled with zeros. 
c. Line G should equal the total PIT withheld and reported on the DE6 quarterly reports. 
d. Line I, contributions paid this year should equal the total CA-Withholding for the 

year for all California employees.  The corresponding liability account in QuickBooks 
must show zero liability owed. 

e. Line J should be zero if the liability account shows zero liability. 
f. Sign and date the bottom of the form 

 
4. Scan the DE7 form and store the PDF file in the State Taxes Folder for the year. 

5. Mail For DE7 to:  

State of California 
Employment Development Department 
PO Box 826288 
Sacramento, CA 942306288 
 

End of Procedure  
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14.7.2 Create 1099 Forms and 1096 Annual Summary and Transmittal of U.S. Information 
Returns (Late December or Early January) 
 

Purpose 
To create the Federal Form 1099 for each person receiving a stipend from the diocese and mail the forms 
to those persons as well as to the IRS 

 
Assumptions 
Sufficient 1099 laser printer forms have been procured 
 
Procedure 
 
1. From QuickBooks, select Vendors/Print 1099s/1096 Forms. 

2. Select #3 Run Report and confirm that the correct reporting year appears on the Modify 
Report: 1099 Summary Window. 

3. Select OK 

4. Confirm that all qualified vendors appear on the list and confirm non-employee 
compensation amounts are correct. 

5. Select Preview 1099.  Select #4 Print 1099s and confirm correct year is displayed.. 

6. Scroll through the forms, confirming that each vendor name, address, and social security 
number is correctly displayed. 

7. Load one set of 1099 forms into the manual tray of the printer. 

8. Click on the Print 1099 button. 

9. Select Print and print the 1099s. 

10. Click on Print 1096 and fill in 1096 information requested.  Click OK. 

11. Mail the 1099s to vendors by January 30. Print the 1099s to a PDF and file in tax records 
folder 

12. Mail 1096 package to the IRS by February 28. Print the 1096 to a PDF and file in tax 
records. 

End Procedure 
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14.7.3 Create W2 and W3 Forms (Late December or Early January) 
 

Purpose 
To prepare the W2 forms to be mailed to diocesan employees 
To prepare the W3 package for the Social Security Administration 

  
Assumptions 

• Sum of all 941 line 2 reported data agrees with YTD payroll summary W3 Box 1 

• Sufficient W2 laser printer forms have been procured, if not filing electronically. 

• If filing electronically, BSO online password must be changed by mid December of each 
year. 

• BSOnline user id and password are provided the Attachment 
 

Procedure File Manually 
1. Open QuickBooks and select Employees/Process Payroll Forms. 

2. The Select Form Type screen will appear. The Radio button for Federal Form should be 
selected.  Click OK. 

3. Select Annual Form W2W3, enter the tax year, and then click OK. 

4. Select all employees and click Review/Edit.  Proceed through the W-2, W-3 interview 
form. 

5. Use buttons to select and review each W2.  (For clergy employees, Box 1 amount should 
equal gross pay less amount withheld for pensions.  

6. If Filing Electronically, go to Procedure File Electronically 

7. Print all employee copies of the W-2 and the W-3.   

8. Mail the W2 forms to employees by January 31. 

9. Print employer copies of the W2s. 

10. Create copy for SSA.  Select the Print W3 button.   

11. Select the Print W3 button. 

12. Return to the main QuickBooks menu.   Exit QuickBooks. 

13. Scan the W2 and W3 forms and save the PDF file in the reporting year payroll taxes 
directory. 

14. Mail the W3 forms and copy A of the W2 forms to the Social Security Administration by 
February 28. 

End Procedure File Manually 
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Procedure File Electronically 
 
1. Print one copy of each W-2 and one copy of the W-3. 

2. Log onto BSO online 

3. Select "Report Wages to Social Security". 

4. Check " I Accept" and select "Submit or Resubmit Wage File, W-2 Online, and W-2c 
Online and view Submission Status. 

5. Under, Create Form W-2 Online, select Enter Form W-2. 

6. Create the W-2 forms and W-3 Form using the forms printed from QuickBooks and 
submit the forms. 

7. Print the confirmation and save under 200X Payroll/Federal 

8. Download and save the submitted W-2s and W-3 to a pdf file under 200X Payroll/Federal 

9. Mail the W2 forms to employees by January 31. 

End Procedure File Electronically 
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14.8 Year-End Close (Draft) 
 

 
1.  Defer revenue of customer payments received in prior year for open invoices in current year.  
 

a.  Create a General Journal Entry for each customer 
Debit the receivable account  
Credit the deferred revenue account 
Date Journal entry as last day of prior year. 
 
b. Create a General Journal Entry dated the first day of the next year, receiving the revenue, 
Credit the receivable account 
Debit the deferred revenue account 
Open the Customer's record and the receive payment window.  Date the payment 1/1/20XX and 
apply the credit. 

 
2. To determine that income has been deferred, i.e. that payments received in December for January 

invoices have been deferred, run the report A/R Aging Detail and look for negative amounts for any 
payments.  There should not be any positive payments on this report that are not balanced with a 
deferred payment.   
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15 CONFIGURE QUICKBOOKS FOR THE DIOCESE OF THE WEST 

15.1 Set up a Parish as a QuickBooks Customer 
 
Each Parish is set up as a QuickBooks Customer, Customer type DOW Parish, with three jobs 
associated with it. 
 
Job:  Assembly 
Customer Type: DOW Parish Assembly 
 
Job:  DPA  
Customer Type:  DOW Parish/DPA  
 
Job:  Fair Share 
Customer Type:  DOW Parish/Fair Share 
 

15.2 Set up a Donor as a QuickBooks Customer 
Each Donor should be set up as a QuickBooks Customer with Customer Type of Donor.  
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16 REPORTING NEW EMPLOYEES TO THE STATE OF CALIFORNIA (ANYTIME) 

Purpose 
The State of California must be notified when a new employee is hired. 

 
Assumption 

• Employees of the Diocese currently include the Bishop, Administrative Assistant, and 
Chancellor. 

• A different person has assumed one of the above positions within the last 20 days. 
 

Procedure 
1. Fill out form DE34Rev 4 (6-00). 

i) Print and mail the form 

End Procedure 
 

Alternate Procedure: Report using the internet 
 
1. Log onto http://eddservices.edd.ca.gov/index.html 
2. Click on iNER. 
3. Refer to the attached hardcopy attachment to find the userid and password for the EDDS 

services web site. 
4. Refer to the attachment to this manual. 
5. Enter the user id and password for the web site 
 
End Procedure  

http://eddservices.edd.ca.gov/index.html�
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17 REPORT INDEPENDENT CONTRACTORS TO THE STATE OF CALIFORNIA 
(ANYTIME) 

Purpose 
To fulfill the requirement of the State of California to report those receiving 1099 Forms as 
contractors as soon as it is expected they will earn over $600.00 for the year. 

 
Assumption 

• All independent contractors must be reported and not just those living in California. 
 

Procedure:  Compile Information and Generate the Reporting Forms 
 

1. Open QuickBooks 

2. Select Reports>Vendors & Payables>1099 Summary 

3. Set the date range to “This Calendar Year”. 

4. Select “Only 1099 Vendors” and “Only 1099 Accounts” and “Ignore Thresholds” 

5. Click OK. 

6. Print the displayed report. 

7. For each vendor, compute the amount to be paid this year. 

8. Close QuickBooks 

9. On the internet, go to the EDD site: https://eddservices.edd.ca.gov/index.html. 

10. Click on Report of Independent Contractors and log into the site.  See the Appendix for 
userid and password. 

11. Select Create New DE542 and fill in the information for all new vendors for this calendar 
year or create a new DE 542 for vendors added during the calendar year 

12. Save the draft, review the form, then save as a pdf file to Diocesan Files/Independent 
Contract Reporting/MM_DD_YYYY ICR. 

13. Select Submit and log off. 

 
End of Procedure 
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18 FILE A CALIFORNIA STATEMENT OF A NON-PROFIT CORPORATION 
(EVERY TWO YEARS) 

 
Purpose 
To report the names of the officers of the Diocese to the State of California and to pay the report 
fee 

 
Assumption 

• A statement is re-filing shall be received every two years.  

• The Treasurer must file a new statement if there is a new Diocesan Secretary or Bishop.  No 
filing charge is incurred in this event. 

 
Procedure 

 
1. Go to the web site http://www.ss.ca.gov/business/business.htm 

2. Select “efile Statement of Information” 

3. Enter the following number in the Corporation Number field – C0733985. 

4. Select “Diocese of the West of the Orthodox Church in America”. 

5. Select “Continue Filing”. 

6. Select the “No” radio button regarding common interest development. 

7. Select “Continue”. 

8. Fill in the displayed form.  Do not use “-“ in zip code separator. 

9. Print from to the Acrobat Distiller. 

10. Select “Continue Filing” 

11. Select “proceed to Checkout” 

12. Use personal Visa Card and fill out payment info. 

13. Select “Process Order”. 

14. Print Confirmation of Receipt of Document/Receipt for Payment. 

15. Select “Return to Main Page” 

16. Exit the Internet 

 
End Procedure 
  

http://www.ss.ca.gov/business/business.htm�
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19 PREPARE FOR EXTERNAL REVIEW OF ACCOUNTS 

 
Purpose 
To prepare the necessary items for review by internal and external auditors/reviewers. 

 
Assumptions 
 
• The previous year financial records are audited by the Audit Committee, preferably before 

July 1st of the following year.   
• An annual  external audit is to be conducted  

• The Diocesan treasurer has created all year-end reports for the previous year.   

• The following previous year materials are ready for review: 
- A copy of the report presented to the Diocesan Assembly  
- A copy of the previous year annual report 
- Deposit and payment records for the previous year, filed by month 
- A binder with materials distributed at previous year Diocesan Council meetings, 

especially Diocesan Council meeting minutes. 
- Payroll and payroll tax records for the previous year 
- Monthly treasurer reports generated for the previous year 
- An accountant’s copy of the QuickBooks file on a CD 
- Copies of auditors’ reports for the previous year 

• The  internal audit has taken place and the report had been generated.  

• An engagement letter has been written and agreed to by the external auditor and the 
Chairman of the internal Audit Committee. 

• The treasurer has scheduled the external audit in June or July of the following year. 

 
Procedure 
1. The treasurer presents the materials to the auditor.   

2. The auditor may do the following tasks in any order or may ask for additional 
information. 

3. The auditor begins with their previous year findings and determines any outstanding 
items. 

4. The auditor reviews the previous year’s final annual report. 

5. The auditor then will select monthly deposit and payment information for one or two 
months 

6. The auditor shall execute the tasks specified in the engagement letter. 

7. The auditor will prepare a management letter. 
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8. The treasurer will include the management letter with the previous-year annual report.  
These items as well as a current year-to-date financial report will be included in the 
Diocesan treasurer’s report to the Diocesan Assembly in October of the current year. 

End of Procedure 
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20 APPENDIX 

20.1 Document Retention Policy 
This Document Retention Policy provides minimum guidelines for mandatory document 
retention and is intended to reduce or eliminate the possibility of accidental destruction of 
documents. This policy assumes that full, complete, and comprehensive internal audits take place 
on an annual basis.   Further, it is assumed that a more detailed definition of “important” will be 
developed in consultation with independent auditors, approved by the Diocesan Council, 
reviewed annually with independent auditors, revised as necessary, and placed as an Addendum 
to this Policy. Other documents may be added to this list as deemed appropriate by the Diocesan 
Council Audit Committee. 

A copy of this policy shall be made available on an annual basis to each employee of the Church 
administration and its departments, as well as to new employees upon hiring. 

Type of Document Minimum Requirement 
Accounts payable ledgers and schedules 7 years 
Audit reports Permanently 
Bank Reconciliations 2 years 
Bank statements 3 years 
Checks (for important payments and purchases) Permanently 
Contracts, mortgages, notes and leases (expired) 7 years from expiration 
Contracts (still in effect) Permanently 
Correspondence (general) 2 years 
Correspondence (legal and important matters) Permanently 
Correspondence (with customers and vendors) 2 years 
Deeds, mortgages, and bills of sale Permanently 
Duplicate deposit slips 2 years 
Employment applications 3 years 
Expense Analyses/expense distribution schedules 7 years 
Year End Financial Statements  Permanently 
Insurance Policies (expired) 3 years from expiration 
Insurance records, current accident reports, claims, policies, etc. Permanently 
Internal audit reports Permanently 
Inventories of products, materials, and supplies 7 years 
Invoices (to customers, from vendors) 7 years 
Minute books, bylaws and charter Permanently 
Payroll records and summaries 7 years 
Personnel files (terminated employees) 7 years 
Retirement and pension records Permanently 
Tax returns and worksheets Permanently 
Timesheets 7 years 
Withholding tax statements 7 years 
Workers’ Compensation records Permanently 

 

Reference: National Council of Nonprofit Associations, www.ncna.org 

 

Section 20.2 of the Appendix is found in a separate file/document. 
 

http://www.ncna.org/�
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